System 800xA
Tools

System Version 6.0

Power and productivity for a better world™
NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously ensure a secure connection between the product and the system network and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs, and so on, to protect the system, its products and networks, against security breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately responsible to ensure that any system update (including but not limited to code changes, configuration file changes, third-party software updates or patches, hardware change out, and so on) is compatible with the security measures implemented. The system/product owners must verify that the system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2015 by ABB.
All rights reserved.

Release: October 2015
Document number: 2PAA101888-600 A
Table of Contents

About this User Manual
Version Described in this User Manual ................................................................. 9
User Manual Conventions .................................................................................. 10
  Warning, Caution, Information, and Tip Icons ........................................... 10
Terminology......................................................................................................... 11
Released User Manuals and Release Notes...................................................... 11

Section 1 - Introduction
ABB Start Menu ................................................................................................. 13

Section 2 - Configuration Wizard
Configuration Wizard Start-up Window ............................................................ 18
  System Software User Settings .................................................................. 20
  Create System.............................................................................................. 22
  Connect Node.............................................................................................. 30
  System Administration............................................................................. 31
  System Extension Maintenance ................................................................. 36
  Start Server................................................................................................. 47
  Stop Server.................................................................................................. 48
  Restore System......................................................................................... 49
  Maintenance............................................................................................... 49
  AppLog ........................................................................................................ 53
  Disconnect Client....................................................................................... 55
  Diagnostics ............................................................................................... 55

Section 3 - System Configuration Console
Understanding the User Interface ................................................................ 57
Using the System Configuration Console ....................................................... 58
Table of Contents

Alarm Management ......................................................................................................... 60
  Alarm Grouping ............................................................................................................. 60
  Alarm Response Navigation ..................................................................................... 60
Appearance and Personalization ..................................................................................... 60
  Object Highlight ...................................................................................................... 60
  Process Object Lock ................................................................................................ 61
  Workplace Configuration ......................................................................................... 61
Clients and Servers ........................................................................................................ 61
  Load Balancing ........................................................................................................ 61
  System Directory Configuration ............................................................................. 62
Maintenance .................................................................................................................... 62
  Backup ...................................................................................................................... 62
  Users ........................................................................................................................ 64
  Security ..................................................................................................................... 64

Section 4 - System Status Viewer
Tools in the System Status Application Bar ................................................................. 68
  Columns .................................................................................................................. 68
System Status Viewer Configuration .......................................................................... 69

Section 5 - Reference Tool
Using the Reference Tool ........................................................................................... 71
  Tab Views ................................................................................................................ 72
  Main Window ........................................................................................................... 73
  Changing References ............................................................................................ 75
  Resolving References ............................................................................................ 75
  Viewing References ................................................................................................. 75
  Approving References ............................................................................................ 76
  Find and Replace .................................................................................................... 76

Section 6 - Consistency Check
Consistency Check Tool ............................................................................................... 78
  Performing a Consistency Check ............................................................................ 80
Resolving and Repairing Errors .................................................................83
Consistency Check for Libraries .................................................................85
Workflow for Consistency Check .................................................................86
    Aspect Assignments .............................................................................87
    Log Configurations .............................................................................88

Section 7 - Diagnostics Collection Tool
Supported Diagnostics Information ..........................................................90
    800xA Plug-ins ....................................................................................90
    Standard Plug-ins ............................................................................90
    On-line Help ....................................................................................91
    Starting DCT ....................................................................................91
Configuring DCT Options ...........................................................................95
    Modifying Results Location ..............................................................95
    Node Execution ................................................................................97
    Deleting Results ..............................................................................97
    General Settings ..............................................................................98
Auto Collector ..........................................................................................99
    Creating an Auto Collector ...............................................................99
    Running an Auto Collector ..............................................................105
Collecting Data .......................................................................................107
    Starting the Collection Tool ............................................................107
    Making Your First Collection .........................................................107
    Description Dialog ..........................................................................112
    Saving Node and Plug-in Selections ................................................113
    Searching For Nodes .......................................................................113
    Download Button ............................................................................114
    Selection Rules ..............................................................................115
    Selection Wizard ............................................................................117
Exploring Data .......................................................................................118
    The Main Window ...........................................................................119
    Using Collection Lists .....................................................................120
    Importing a Collection ....................................................................122
# Table of Contents

- Viewing Collection Properties ......................................................... 123
- Using Collection Contents List ......................................................... 124
- Opening a Collected File ................................................................. 125
- Locating a Collected File ................................................................. 126
- View Collection Log ........................................................................ 126

## Analyzing Data .............................................................................. 128
- Select Collection to Analyze ......................................................... 129
- Analyze Software ........................................................................... 131
- Analyze Processes ......................................................................... 133
- Search in Collections or ABB Library ........................................... 134

## Analyze Controllers Firmware and Log Files ................................ 138
- Analyzing the Log Files ................................................................. 139
- Viewing Logs .................................................................................. 139
- Comparing Between Nodes ............................................................ 141
- Comparing With a Saved Collection .............................................. 142

## Collect Software Consistency Data ................................................. 143

## Plug-ins .......................................................................................... 145
- IndustrialIT Related Plug-ins ......................................................... 145
- Standard Plug-ins .......................................................................... 155

## DCT Error Diagnostic Message .................................................... 162

## Frequently Asked Questions (FAQ) ............................................... 162

## Installation of DCT .......................................................................... 163

## Revision History

## Index
About this User Manual

Any security measures described in this document, for example, for user access, password security, network security, firewalls, virus protection, and so on, represent possible steps that a user of an 800xA System may want to consider based on a risk assessment for a particular application and installation. This risk assessment, as well as the proper implementation, configuration, installation, operation, administration, and maintenance of all relevant security related equipment, software, and procedures, are the responsibility of the user of the 800xA System.

This User Manual describes some of the tools used to configure, check, and verify an 800xA system.

The User Manual describes for example:

• Configure and administrate an Operator Workplace (Section 2, Configuration Wizard).

• Configure an Operator Workplace using a simplified configuration console (Section 3, System Configuration Console).

• View System Status information (Section 4, System Status Viewer).

• Gather diagnostic data from nodes (Section 7, Diagnostics Collection Tool).

Version Described in this User Manual

Unless otherwise noted, the versions of all 800xA Base System and Functional Area software described in this user manual are the latest release of 800xA 6.0.
User Manual Conventions

Microsoft Windows conventions as defined in the Microsoft Manual of Style are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, and so on.

Warning, Caution, Information, and Tip Icons

This user manual includes **Warning**, **Caution**, and **Information** where appropriate to point out safety related or other important information. It also includes **Tip** to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

- **Electrical warning icon**: Indicates the presence of a hazard which could result in **electrical shock**.

- **Warning icon**: Indicates the presence of a hazard which could result in **personal injury**.

- **Caution icon**: Indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in **corruption of software or damage to equipment/property**.

- **Information icon**: Alerts the reader to pertinent facts and conditions.

- **Tip icon**: Indicates advice on, for example, how to design your project or how to use a certain function.

Although **Warning** hazards are related to personal injury, and **Caution** hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, **fully comply** with all **Warning** and **Caution** notices.
Terminology

A complete and comprehensive list of Terms is included in the System 800xA, System Guide, Functional Description (3BSE038018*). The listing included in includes terms and definitions as they apply to the 800xA system where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely apply to this User Manual are listed in the following table.

<table>
<thead>
<tr>
<th>Term/Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCT</td>
<td>Diagnostics Collection Tool.</td>
</tr>
<tr>
<td>Plug-in</td>
<td>A module in DCT that collects a specific type of data. For example &quot;Installed Software&quot; or &quot;Event Log&quot;.</td>
</tr>
<tr>
<td>Node Interrogator</td>
<td>A service that is running on all machines (&quot;nodes&quot;) which have DCT installed. This DCT uses the Node Interrogator to collect data, plug-ins list etc.</td>
</tr>
<tr>
<td>Command File</td>
<td>A file containing a node and plug-in selection. These files are created in the Collection Tool by saving the current selection.</td>
</tr>
<tr>
<td>Collection</td>
<td>A collection is the result of collecting data. All data collected at a certain time is considered to be part of the same collection, regardless of how many nodes and plug-ins that were collected from. Data collected from one node is compressed and zipped into a single file. All these compressed files together (one file from each node) will make a collection.</td>
</tr>
</tbody>
</table>

Released User Manuals and Release Notes

A complete list of all User Manuals and Release Notes applicable to System 800xA is provided in System 800xA Released User Documents (3BUA000263*).

System 800xA Released User Documents (3BUA000263*) is updated each time a document is updated or a new document is released. It is in pdf format and is provided in the following ways:
• Included on the documentation media provided with the system and published to ABB SolutionsBank when released as part of a major or minor release, Service Pack, Feature Pack, or System Revision.

• Published to ABB SolutionsBank when a User Manual or Release Note is updated in between any of the release cycles listed in the first bullet.

A product bulletin is published each time System 800xA Released User Documents (3BUA000263*) is updated and published to ABB SolutionsBank.
Section 1 Introduction

The latest version of this manual is available in ABB SolutionsBank.

This manual describes the tools available, and their purpose in the 800xA System. These tools help in administration and configuration of a 800xA System, namely:

- Configuration Wizard
- System Configuration Console
- System Status Viewer
- Diagnostic Collection Tool
- Consistency Check

All the above mentioned tools can be accessed through the newly introduced ABB Start menu.

ABB Start Menu

ABB Start menu is introduced in this release to access the ABB applications with ease. Figure 1 is a snapshot of ABB Start menu.

It has various menu items categorized under different folders that are organized in a collapsible tree structure. Users can open the relevant folder and click the appropriate menu item to launch the required ABB application.
The ABB Start menu can be accessed in the following ways:

- The ABB Start menu is available as a shortcut in the Desktop as shown in Figure 5.

![ABB Start Menu](image1.png)

*Figure 1. ABB Start Menu*

*Figure 2. Accessing ABB Start Menu through the Desktop shortcut*
The ABB Start menu is available in the Apps screen as shown in Figure 3.

![Image of APPS screen showing ABB Start Menu](image1)

*Figure 3. Accessing ABB Start Menu through the Apps Screen*

The ABB Start menu can be opened using Windows Search as shown in Figure 4.

![Image of Search window with ABB Start Menu](image2)

*Figure 4. Accessing ABB Start Menu through the Search Window*

The ABB Start Menu can be pinned in the taskbar as shown in Figure 5.
Select the **ABB Start Menu** available from the Desktop or Apps screen or Windows search and right-click **Pin to Taskbar**.

*Figure 5. Accessing ABB Start Menu through the Taskbar*

If a user installs or un-installs any ABB application, it automatically reflects in the ABB Start menu.
Section 2 Configuration Wizard

You must have 800xA Installer administrator rights to perform the tasks in this section.

The Configuration Wizard is used for performing all the configuration and administration after a completed installation of the Operator Workplace. The Configuration Wizard handles both the server and client configuration.

Open ABB Start Menu > ABB Industrial IT 800xA > System > Configuration Wizard.

You can browse through the steps by clicking the Back and Next buttons at the bottom of each dialog box. You can always return to a previous dialog box and make changes before applying the configuration data. No data will be applied until the last dialog box of each wizard task is reached, where you click Apply or Finish.

During installation, upgrade, and configuring the system, use System Configuration Console (SCC) instead of Configuration Wizard. SCC is used to configure the system for the following configuration items:

- Creating a new system.
- Adding and removing Clients and Servers.
- Connecting Clients.
- Handling System Extensions.

When Configuration Wizard is started, a message appears as shown in the Figure 6.
Configuration Wizard Start-up Window

When the Configuration Wizard is started it shows a start-up window from which all wizard tasks are started, see Figure 7. The tasks are:

- **System software User settings**, configuration of the service account.
- **System Administration**, start, stop, delete and maintenance of systems.
- **Start Server**, starts all manually started systems on a server.
- **Stop Server**, stops all systems running on a server.
- **Create System**, creation and initialization of systems.
- **Restore System**, restores a saved system.
- **Maintenance**, maintenance of the server.
- **Applog**, applog configuration.
- **Connect Node**, connect a client or server node to an existing system.
• **Disconnect Client**, disconnect a client connected to a system.
• **Diagnostics**, enabling of fault detection routines.

Additional tasks may be added depending on connect families used. They are documented in product specific manuals.

![Configuration Wizard Start-Up Dialog Box](image)

**Figure 7. Configuration Wizard Start-Up Dialog Box**

If you are running the Configuration Wizard from a server the tasks in Figure 7 are shown. If you are running the Configuration Wizard from a client the tasks **System software User settings, Create System, Restore System, Applog, Connect Node, Disconnect Client and Diagnostics** are shown. The **System Administration, Start Server, Stop Server** tasks are shown, on a server, when the system is created. The **Disconnect Client** task is shown on the client when you have connected it to a system.
If only **System software User settings** is visible, make sure you are a member of the IndustrialITAdmin group and have the right to administrate users on the local machine or on the Domain Controller, and repeat the task **System software User settings**.

### System Software User Settings

The user administration is based on Windows user administration. To register a user as a Windows user, see Microsoft documentation.

When you select the task **System software User settings**, **Configuration Wizard**, **System software User Settings** dialog box is displayed, see **Figure 8**.

![Configuration Wizard](image)

**Figure 8. System Software User Settings Dialog Box**
- **System Admin, group name**
  Members of this group have full rights in the System. Very few should be members of this group. By default this Windows group is named **IndustrialITAdmin**.

- **System User, group name**
  All 800xA System users must belong to this group. By default this Windows group is named **IndustrialITUser**.

- **Service Account, used by System software**
  All System services run under this account. At startup the default account name is displayed. The Service Account must be local administrator on all machines.

The entered groups are added to the Windows system if they do not already exist. If you want to register the System Administrator and System User groups in a domain other than the local machine, you have to enter the domain in the **Domain** field.

If the user selects the **Autostart System on Windows startup**, the 800xA server starts automatically along with the computer. This is not a recommended setting when using a notebook, since the system requires a lot of resources.

If you select the **Apply these settings to Application logging, too** the Applog function (see **AppLog** on page 53) will start with the specified service account.

Use the NetBIOS name of the domain, eg “PTTDOMAIN” and not the fully qualified domain name “pttdomain.abb.com”.

The windows groups created by the system are:

- **IndustrialITAdmin** (may be renamed during installation in the installation wizard).
  A member of this group runs all the services and has full access to the system.

- **IndustrialITUser** (may be renamed during installation in the installation wizard).
  All IndustrialIT 800xA users.
After the new Windows groups are created, users can be added to the groups.

- All users of the 800xA System must be members of the System User group, which by default is, the Windows group **IndustrialITUser**.

Members of the System Admin group is running the system with full access, i.e. with the Security system disabled.

- Do not perform any configuration or administration work as 800xA Service user (the account reserved for use by 800xA system services). Major functions like audit trail and import/export will not work properly if configuration is performed while logged in as the Service user. It is recommended to disable the interactive login possibility for the Service user. It is also recommended that each person using the 800xA System has a user account with the appropriate user roles defined for this. This enables the possibility to synchronize or export the modifications performed by a certain person.

System Software User Settings is part of the product installation if needed, can also be applied after the installation.

- If a wrong setting, regarding to the windows accounts is detected, a padlock is shown in the tray icon (shown in the lower right corner of the screen). This is to prevent the windows accounts of the user to be locked.

See the padlock in the figure below.

In most scenarios, the padlock is a result of an account verification that is not permitted by the domain controller. To remove the padlock symbol and release the lock state, reapply the System Software User Settings with the settings used when installing the product.

**Create System**

When the system is created, using the **Create System** in the Configuration Wizard, the user currently logged in is added to the system as member of the IndustrialIT 800xA groups **Everyone, System Engineer** and **Application Engineer**.
It is recommended that the same user account that installed the 800xA also shall create the system.

US English should be used when creating the system. If you want the system to be in other language than US English, you should install the translation of the wanted language and add the translation using Add System Extension.

Note that an Application Engineer does not have an Operator Role by default. This means that there are tasks an Operator can perform, that an Application Engineer can not.

It is recommended to add the System Engineer to the Application Engineer group. It is also recommended to add the Application Engineer to the Operator group.

1. Start the Configuration Wizard from the ABB Start Menu.
2. Select **Create System**, and click **Next**.
3. The Create New System dialog box is displayed. It is used to create an Industrial™ 800xA System on the Aspect Server node. Enter a **Name** and a **Description** for the system, then select one of the radio buttons in the **Server Type** area.
Server type **Aspect Server** is used for medium and large configurations when it is recommended to run Aspect Server and Connectivity Server on separate nodes. The Connectivity Server must then be added later on, see **Nodes** on page 38.

Server type **Aspect Server and Connectivity Server** is used for small configurations such as a Single node configuration. If this Server Type is marked the Aspect and Connectivity Server will run on the same node.
4. In the next dialog box you specify data directories, see Figure 11.

![Configuration Wizard](image)

**Figure 11. Define Data Directories**

Use a local disc on the Aspect Server node. Using a network disc will severely decrease the performance of the server and risk the entire system availability.

5. If not using network filtering click **Next** in the next dialog box. This will take you directly to **Step 7**. If using network filtering mark the **Use network filtering** check box. Enter the number of network areas used in the **Number of network areas** text field. Click **Next**. For more information about network filtering and areas, see *System 800xA, Network, Configuration (3BSE034463*)*. 
Figure 12. Configure System Network
6. In the next dialog box specify the primary and secondary network address for the first network area. If more than one network area was specified in the previous dialog box, one dialog box for each area will appear. Click **Next**.

![Figure 13. Configure Network Area Address](image-url)

*Figure 13. Configure Network Area Address*
Section 2  Configuration Wizard

Create System

7. Verify your settings in the Apply Settings dialog box, see Figure 14.

![Apply Settings Dialog Box]

Figure 14. Apply Settings Dialog Box

8. Click Finish if the settings are fine. The system is created.
   To start the created system it may take some time.

Change of Password

If a system has not yet been created and the service account owner changes the Windows password, the first user who tries to start the Configuration Wizard must know the new password. You can create a system only after the new password is entered in the System software User settings dialog box.
Connect Node

Before a client is able to connect to a system, the Workplace client must be enabled from the server. This is done in the Add Client dialog box as described in Nodes on page 38.

The System Configuration Console task System Directory Configuration is used to configure what disks to use for the services running on a server node. Refer to System Directory Configuration on page 62.

In the Connect Node dialog box, go to the Connect to another System on Node drop-down menu and select the node, then click Next.

In the Connect to System dialog box mark the Set as default system check box, see Figure 15. This changes the default system for the client to be the same as the default system on the connected server.

You can connect a client, and set up its default system from the server node, with the Add Client task, without having to go to the client node physically.

Figure 15. Connect to System Dialog Box
System Administration

General

To enter the Configuration Wizard task for system administration select the **System Administration** task in the Configuration Wizard and click **Next**, see Figure 7. In the Select System dialog box, select the system you want to administrate, see Figure 16. Click **Next**.

![Figure 16. Select System Dialog Box](image)

In this version only one system is supported.

The Configuration Wizard task for system administration appears.

![Figure 17. System Administration Dialog Box](image)
The following administrative tasks are performed with this Configuration Wizard task:

- **System Extension Maintenance**, used for loading of system extension updates.
- **System Extension Load**, used for loading of system extensions.
- **Systems**
  - Start, start of the services for a system.
  - Stop, stop of the services for a system.
  - Delete, delete a system.
  - Set Default, setting the default system.
- **Nodes**
  - Remove Client, remove client nodes from a system.
  - Add Client, add client nodes to a system.
  - Remove Server.
  - Add Connectivity Server.
  - Add Redundant Server.
- **System Network**, configure system network and network area addresses.
- **Users**, add and remove users to/from a system.
- **Environment setup**, enabling of multiple environments.

**System Extension Load**

The System Extension Load dialog box is used to add a system extension to a system after its creation.

1. Start the Configuration Wizard on the primary Aspect Server node.
2. Open the System Extension Load dialog by selecting: **System Administration > Select System > System Extension Load.**

![System Extension Load Dialog Box](image-url)

*Figure 18. System Extension Load Dialog Box*
3. Select the system extension to load in the list in the left pane and move it to the list in the right pane by clicking >. To move all the system extensions from the left pane to the right pane, click >>.

![Configuration Wizard](image1)

*Figure 19. System Extension Load - Selected System Extensions*

4. The Red Cross, Green Checkmark and Warning icons indicate the status of the dependency evaluation. The Green Checkmark icon indicates that the system extension must be added first, and the Red Cross icon indicates that the system extension can not be added until the dependencies are loaded. The order of which the extensions in the right column list will be loaded is top-down. The Warning icon indicates that the system extension can be loaded, but that there is additional information available in the lower part of the dialog box. The additional information can for example be that the system extension contains aspect types that are not environment aware.

If the list in the right pane contains more than one system extension, click **Press header to autosort** to sort the system extension load order with regard to dependencies.

![Configuration Wizard](image2)

*Figure 20. System Extension Load - Ok to Load*
5. All system extensions in the right pane should be marked with the Green Checkmark icon or the Warning icon, click **Next** and the Apply Settings dialog box appears.

6. Click **Finish**. The system extensions will load into the system.

7. A progress dialog is shown during the load. Click **View Log** to view log messages during load.

   The load is aborted if:
   - the user aborts the load by clicking the **Abort** button.
   - an error occurs, for example if the Configuration Wizard fails to load a file into the system.

   An aborted system extension load can be resumed from the **System Extension Maintenance** dialog.

8. When the load operation is finished, click **Finished** and view the Configuration Wizard log to verify that no errors occurred during the load.

   The server must be running to start the system.

After the system extension maintenance load is completed, sometimes the older customer adaptations are overwritten by the default system configuration updates that exist in the same import file.

Therefore, it is recommended that a list of customer adaptations is extracted from the existing system before the update or upgrade. This can be done using the **Find Tool**.

The Find Tool provides functionality to search for Objects and Aspects. It is possible to extend the tool and search features with attributes, columns, and additional operations. It is possible to search for Aspects created by a system extension, which has been modified by an user account.

To know more on collecting the data of the customized Aspects before the system update or upgrade, refer to the **System 800xA 5.1 to 6.0 Upgrade Manual (2PAA111694*)**.

For more information about using the Find Tool, refer to the **System 800xA Operations Operator Workplace Configuration (3BSE030322*)**.
System Extension Maintenance

System Extension Maintenance is used to load updates into the system, for example, service packs. It can be also be used to resume aborted system extension loads.

See System Extension Load on page 32 for information on how to load an update of a system extension.

Systems

Start System. To start a system follow the steps below:

1. Go to the Configuration Wizard and select System Administration, click Next.
2. Mark the system you want to start and click Next.
4. Select Start in the Systems dialog box and click Next.

5. Click Finish in the Apply Settings dialog box. The system is now started.

Stop System. To stop a system follow the steps below:

1. Go to the Configuration Wizard and select System Administration, click Next.
2. Mark the system you want to stop and click Next.
3. Select **Systems**, and click **Next**.

4. Select **Stop** in the Systems dialog box and click **Next**, see Figure 21.

5. Click **Finish** in the Apply Settings dialog box.

**Delete System.**

When the system is deleted all application data is also deleted. If you want to save the data, you have to export it using the Import/Export tool, or you can perform a backup.

When making an upgrade from one version of the system to another you use the Backup and Restore function.

The following does not apply to a system running with redundant Aspect and/or parallel Connectivity Servers. Then you first have to stop the servers by choosing **Stop Server** in the Configuration Wizard Startup window before deleting the system. For more information about stopping the server see **Stop Server** on page 48.

To delete a system follow the steps below:

1. Go to the Configuration Wizard and select **System Administration**, and click **Next**.

2. Mark the system you want to delete. Click **Next**.

3. Select **Systems** and click **Next**.

4. Select **Delete**, see Figure 21, click **Next**.

5. Select system and click **Next**.

6. Click **Finish** in the Apply Settings dialog box.

7. Wait a few minutes, and when the Configuration Wizard appears again with the System dialog box the deletion of the system is completed.

8. Click **Exit**.

**Set Default**

If you want to have a certain system as default system follow the steps below:

1. Select **Set Default** in the Systems dialog box, see Figure 21.
2. In the next dialog box, choose which system that shall be the default system, then click **Next**.

3. Click **Finish** in the Apply Settings dialog box.

The selected system is now the default system, and the System Administration dialog box will appear.

**Nodes**

**Remove Client.** To remove a client follow the steps below:

1. In the System Administration dialog box, see **Figure 17**, select **Nodes** and click **Next**.

2. Select **Remove Client**, see **Figure 22**, and click **Next**.

3. Select the client that shall be removed. It is recommended to check the **Update remote node** check box. If it is checked services will be stopped in the remote node. Click **Next**.

4. Click **Finish** when the Apply Settings dialog box is shown. The client is now removed and the System Administration dialog box will appear.

---

**Figure 22. Nodes Administration Dialog Box**
Add Client. The Add Client dialog box is used to add client nodes to a server. You must run this command on the server node. Only nodes added this way can connect to the server.

Before adding a client, make sure that the node to be added has 800xA System installed. It must also have the same system extensions as the Aspect Server.

To add a client follow the steps:

1. In System Administration dialog box, see Figure 17, select Nodes and click Next.
2. Select Add Client and click Next.
3. Select the node to add in the Client Node drop-down menu, see Figure 23. Click Next.
4. If the Update remote node check box is marked, this server will be added to the clients lists of servers. If the Set as default system check box is selected, the default system on the server will be set as the default system on the added node as well.
5. In the next dialog box, click Finish.

You can enable several clients without updating the remote node or set the default system. This makes it possible to later on connect the client to the server from the client node without having to do any work on the server node.

Note that clients do not give status information. This means that the System Status Viewer in the Node Administration Structure, only gives status from servers. Refer to Section 4, System Status Viewer.
Remove Server.

To stop and remove a Connectivity Server, begin with stopping the server, see Stop Server on page 48.

1. Go to System Administration > Nodes, and select Remove Server.
2. Select the server node to be removed in the Remove Server Node dialog box and click Next.
3. Click Finish in the Apply Settings dialog box.

The remove server wizard task is also used if you shall change from a redundant configuration to a single configuration.

Add Connectivity Server.

System 800xA software must be installed on a connectivity server before adding the server to the system. For System 800xA software installation, refer to System 800xA Installation and Upgrade Getting Started Manual (2PAA111708*).

The System Configuration Console task System Directory Configuration is used to configure what disks to use for the services running on a server node. Refer to System Directory Configuration on page 62.

Perform the following steps to add a Connectivity Server:

1. In System Administration dialog box select Nodes, and click Next.
2. Select Add Connectivity Server, and click Next.
3. Finally select Connectivity Server node from the drop-down menu in the Add Server Node dialog box. Click Next.

It is recommended to check the Update remote node check box. If it is checked the server will be updated and activated.

Figure 24. Add Server Node Dialog Box
4. Click **Finish** in the Apply Settings dialog box.

**Add Redundant Server.**

Before adding a redundant server, which could be a Connectivity Server or an Aspect Server, make sure that the node to be added has 800xA System installed. It must also have the same system extensions as the primary Aspect Server.

The System Configuration Console task System Directory Configuration is used to configure what disks to use for the services running on a server node. Refer to **System Directory Configuration** on page 62.

Follow the steps below to add a redundant server:

1. In System Administration dialog box, select **Nodes**, and click **Next**.
2. Select **Add Redundant Server**, and click **Next**.
3. In the next dialog box, a list of server nodes, both Aspect and Connectivity Servers, are shown. Select the server node to be duplicated, click **Next**.
4. In the Add Redundant Server Node dialog box select node in the **Client Node** drop-down menu, and click **Next**.

   It is recommended to check the Update remote node check box. If it is checked the server will be updated and activated.

5. Click **Finish** in the Apply Settings dialog box.

**System Network**

Follow the steps below to configure system network addresses:

1. Go to the Configuration Wizard and select **System Administration**, click **Next**.
2. Mark the system you want to start and click **Next**.
3. Select **System Network**, click **Next**.
4. If using network filtering mark the **Use network filtering** check box. Enter the number of network areas used in the **Number of network areas** text field. Click **Next**.
For more information about RNRP and areas see *System 800xA, Network, Configuration (3BSE034463)*.

**Figure 25. Configure System Network**
5. In the next dialog box specify the primary and secondary network address for the first network area. If more than one network area was specified in the previous dialog box, one dialog box for each area will appear. Click Next.

![Configuration Wizard](image)

*Figure 26. Configure Network Area Address*

6. Verify your settings in the Apply Settings dialog box, if the settings are ok, click Finish.

**Operator Workplace User Administration.** The Users icon in the Configuration Wizard activates the User Administration dialog box.

1. Open the Configuration Wizard.

2. Select System Administration and click Next.

3. Select the system in which you want to configure users to and click Next. See Figure 16.
4. Select **Users**, see Figure 17. The User Configuration dialog box is displayed, see Figure 27.

**Figure 27. User Configuration Dialog Box**

The top window shows the Industrial**IT** 800xA System users. Users can be added and deleted. To delete a user select the user in the top window and click **Delete User**. The **Reset** button is used to reset the group membership for a user to the state it was before any changes were made.

You must have administrator permissions to delete a user.

To add a Windows user to an System 800xA group follow the steps:

1. Click **Add Windows Accounts**.
2. The list of the Windows users of the selected domain are shown, see Figure 28. Select the Windows users you want to add to the System 800xA users and click Add.

![Assign Windows Account Dialog Box](image)

*Figure 28. Assign Windows Account Dialog Box*

3. Repeat Step 2 to add more Windows users. Click OK.

4. In the User Configuration dialog box, you can select the Industrial\(^\text{IT}\) 800xA groups of which a Windows user must be member, see Figure 27. Select Windows user in the top window and use the **Remove** and **Add** buttons to move Industrial\(^\text{IT}\) 800xA groups to the **Member of** field.

**Environment Setup**

The Environment Setup dialog box is used for enabling of multiple environments.

A license is required both for the Environment support option and for the Load-Evaluate-Go support option.
Follow the steps below to enable the function:

1. Start the Configuration Wizard and select System Administration > Environment Setup.

2. Select the Environment support check box if you want to enable version handling. This action is non-reversible. See Figure 29.

3. If you want to enable the Load-Evaluate-Go support (only possible to select if Environment support is selected) select the Load-Evaluate-Go check box. For more information regarding version handling and Load-Evaluate-Go see System 800xA, Engineering, Engineering and Production Environments (3BSE045030*).

4. Click Next.
5. Click **Finish** in the Apply Settings dialog box.

The **Refresh engineering environment** check box is used if you want to make the Engineering Environment identical to the Production Environment. Note that this action will remove all modifications made in the Engineering Environment.

**Start Server**

To start a server follow the steps below:

1. Select **Start Server** in the Configuration Wizard and click **Next**. The system in some scenarios can prompt for a reboot. For details, refer to the information after step three.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System software</td>
<td>Windows Users and Groups used by the System software</td>
</tr>
<tr>
<td>User settings</td>
<td></td>
</tr>
<tr>
<td>System Administration</td>
<td>Start, stop, delete and maintainance of system</td>
</tr>
<tr>
<td><strong>Start Server</strong></td>
<td>Starts all manually started systems on a server</td>
</tr>
<tr>
<td>Stop Server</td>
<td>Stops all systems running on a server</td>
</tr>
<tr>
<td>Create System</td>
<td>Creates a new system</td>
</tr>
<tr>
<td>Restore System</td>
<td>Restores a saved system</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Maintenance functions for the local machine.</td>
</tr>
<tr>
<td>Applog</td>
<td>Applog settings</td>
</tr>
<tr>
<td>Connect Node</td>
<td>Connect this computer to a system</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Allows enabling of fault detection routines</td>
</tr>
</tbody>
</table>

*Figure 30. Configuration Wizard - Start Server*

2. Select the server that shall be started.
3. Click **Finish** in the Apply Settings dialog box.

   The system prompts for a reboot. This happens if **Stop all processes associated with the Process Portal A** has been executed on the selected node and that node has not been rebooted. If **Start Server** is executed locally the user is given the option to reboot immediately. If **Start Server** is executed on a remote server that node must be rebooted there.

   If the system is stopped the user needs to start the system apart from starting the server.

---

**Stop Server**

To stop a server follow the steps below:

1. Select **Stop Server** in the Configuration Wizard and click **Next**.

   ![Configuration Wizard - Stop Server](image)

   **Figure 31. Configuration Wizard - Stop Server**

2. Select the server that shall be stopped in the Shut-down Server dialog box, and click **Next**.

3. Click **Finish** in the Apply Settings dialog box.
Section 2  Configuration Wizard

Restore System

The restore will recreate an equivalent system, after a node failure. It is also a recommended way to transfer data between one version of the system to another during an upgrade. A restore of a system is performed from the Configuration Wizard. The same or a later version of 800xA System and any System Extension that was installed when the backup was done, need to be installed before the system is being restored.

Maintenance

Available under the Maintenance wizard task are functions to use when upgrading. You can also change the Service Account password. See Figure 32.

Figure 32. Configuration Wizard - Maintenance

If you want to change the Service Account when you already have a created system, causes problems when starting the system. In that case make sure the new Service Account is correctly configured and added to the 800xA system.

To change password when you already have a created system, see Change Service Account Password on page 51.
Stop all Processes

1. When upgrading all processes must be stopped. Mark the **Stop all processes associated with the Process Portal A** and click **Next**.

2. Click **Finish** in the Apply Settings dialog box.

3. The system prompts for a reboot. The node must be rebooted before the server is rebooted.

**Set Default Drive**

When adding a server you might not want to have the Workplace Data of the system on the same drive as the Installation Files. You can change this by selecting **Set Default Driver for remote actions**, and select your own drive. See Figure 34.
You must change the drive locally in the server before you can add it to the system.

![Configuration Wizard](image)

**Figure 34. Maintenance - Set Default Drive**

**Change Service Account Password**

If the password for the windows account used as the 800xA Service Account is changed it is also necessary to update the stored logon password on each node in the system. This can be done with **System Software User Settings** if the system on the node can be shutdown.

If it is desired to change the password “on the fly”, **Change stored logon password for the service account** must be used. In this way the new password will be used on the next service logon. The stored password will be updated for the ABB Service
Manager and ABB 800xA Notification Service. Stored passwords will also be updated for the AppLog service and Client Service Provider service if they use the same account as the 800xA Service account.

1. Mark the **Change Service Account Password** radio button. See Figure 35.

   ![Figure 35. Maintenance - Change Service Account Password](image)

2. The service account name is shown by default.

3. Enter the new password (the password set in the domain) in the **Password** text field. Click **Next**.

4. Click **Finish** in the next dialog box.
AppLog

AppLog is a tool for getting information of an Industrial IT 800xA System and for examining how the system is working.

The Applog tool is mainly used by ABB service engineers.

Start AppLog

To configure the AppLog manually follow the steps below:

1. Select Applog in the Configuration Wizard and click Next.

2. Mark the Enable AppLog Service check box in the Applog configuration dialog box. Enter the User ID with domain and password in the AppLog service settings area.

Mark the Autostart service on Windows startup check box. AppLog will then be started when Windows is started. Select Start in the Action area.
See Figure 36.

![Configuration Wizard]

Figure 36. Applog Configuration Dialog Box

3. Click **Next**.
4. Click **Finish** in the Apply Settings dialog box.

**Stop AppLog**

To stop the AppLog server follow the step below:
1. Select **Applog** in the Configuration Wizard and click **Next**.
2. Select **Stop** in the **Actions** area.
3. Click **Next** then click **Finish**. The AppLog server is now stopped.
Restart AppLog

To restart the AppLog server follow the steps below:

1. Select Applog in the Configuration Wizard and click Next.
2. Select Restart in the Actions area.
3. Click Next then click Finish. The AppLog server is now restarted.

Disconnect Client

This task is only available on a client node when the client is connected to a system.
To disconnect a client follow the steps below:

1. Select Disconnect Client in the Configuration Wizard, click Next.
2. Choose the system from which the client shall be disconnected, click Next.
3. Click Finish. The client is now disconnected from the system and the Configuration Wizard window will appear.

Diagnostics

In the Diagnostics task you can configure the Watchdog function.

The Diagnostics settings should only be used by ABB service engineers.

To configure this function follow the steps below:

1. Start the Configuration Wizard and select Diagnostics and click Next.
2. To enable the Watchdog function select the Enable Watchdog check box, see Figure 37. When this function is enabled, unresponsive windows are indicated with a red frame. The Heartbeat Time is by default set to 30 seconds. A dump file can be saved containing information about the state of the
workplace. This information can be used by ABB service engineers to facilitate their fault tracing.

3. Click **Next** when you are done with the configuration.
4. Click **Finish** in the Apply Settings dialog box.
The System Configuration Console is a dashboard that provides a single entry point for the global configuration settings of an 800xA system. The simple and intuitive user interface of this tool logically classifies the configuration task groups that the user can use for configuring the system. The task-centric framework allows easy navigation between the tasks and task groups.

The System Configuration Console provides an easy-to-use user interface for configuring the system and does not replace the Configuration Wizard.

The System Configuration Console is loaded as part of the 800xA Base installation.

Open ABB Start Menu > ABB Industrial IT 800xA > System > Configuration Wizard.

**Understanding the User Interface**

The System Configuration Console user interface consists of a navigation bar, a left pane, and a task pane, see **Figure 38**.

![Figure 38. System Configuration Console](image-url)
The navigation bar includes navigation buttons and search options. The navigation bar also provides breadcrumbs that allow the user to track the location of a current page on the UI. The Home link allows the user to return to the default page from any view.

The left pane provides a quick access to the recent events and tasks. The Recent events list displays links to important events that require immediate user action, for example, Last backup failed. The Recent tasks list displays the recent tasks in a chronological order that the user has executed.

The history of recent events and tasks is lost when the application is closed and reopened.

The List all tasks link displays all the tasks that the user can execute through this tool. To view or modify a task listed in the left pane, click the particular task to view the corresponding details in the task pane.

The task pane displays the main administrative tasks and tools. To modify or administer an item, select it and click a task in the task pane to view the details.

---

**Using the System Configuration Console**

The System Configuration Console is started in different modes based on the system availability. If no system is available, the application is started in the start-up mode. For more information about start-up tasks, refer to Start-up Mode Tasks on page 58. If there is an existing system, the application is started in the configuration mode. For more information about configuration related tasks, refer to Configuration Tasks on page 59.

**Start-up Mode Tasks**

The Create System task is available in the start-up mode. The user can create a new 800xA system.

Follow the steps to create a new system:

1. Click the Create a new 800xA System task. Enter the Name and Description of the new system.
2. Select the Server Type as Aspect Server or Aspect and Connectivity Server.
3. Enter the folder path to store the following data:
   - Server Data.
   - Server Data 2.
   - Workplace Data.
   - System Data.

4. Configure the network depending on the number of network areas.

The System Configuration Console creates a system with the preferred configuration. The **Create System** task also loads all the appropriate system extensions.

**Configuration Tasks**

The SCM tool in the normal mode displays the tasks to administer a running 800xA system.

Configuration tasks are grouped as follows:

- Alarm Management.
- Appearance and Personalization.
- Licensing.
- Maintenance.
- Clients and Servers.
- Security.
- Users.
Alarm Management

The Alarm Management task group allows the user to setup and configure the Alarm Grouping and Alarm Response Navigation functionalities.

Alarm Grouping

Alarm Grouping is a feature in the 800xA system that allows grouping of several alarms that requires a similar response from the operator. For more information about Alarm Grouping, refer to System 800xA Configuration (3BDS011222*).

Alarm Response Navigation

The Alarm Response Navigation feature allows the operator to navigate quickly to different aspects from an object. The following are the features of Alarm Response Navigation:

- Quick navigation to single or multiple aspects using the object context menu or through the Alarm and Event List.
- One time configuration or detailed configuration to enable quick navigation for all types of objects or for an object or object instance respectively.

For more information on configuring the Alarm Response Navigation, refer to System 800xA Operator Workplace Configuration (3BSE030322*).

Appearance and Personalization

The Appearance and Personalization task group includes the settings that affect the appearance of the 800xA system.

Object Highlight

The user can configure the following object highlight settings:

- Object Highlight Mode / Behavior (None, Follow Faceplate, Follow Mouse).
- Highlight Layout.

Highlight Layout includes the style of the frame, width, padding, and color.
Refer to *System 800xA, Operations (3BSE036904*) for more information about object highlighting.

These settings will apply only to PG2 graphics.

**Process Object Lock**

The user can configure process object lock using this user interface. Refer to *System 800xA, Administration and Security (3BSE037410*) for information about Process Object Lock.

**Workplace Configuration**

The user can use the Workplace task group to manage workplace configurations.

**Clients and Servers**

The Clients and Servers task group includes the following tasks:

- Load Balancing.
- System Directory Configuration.

**Load Balancing**

Balancing the client load among the redundant servers increases the overall performance of the system. Load balancing configuration through the System Configuration Console depends on the number of redundant servers and the corresponding failover scenarios that can occur in the system.

**Assigning Clients to Servers**

The 800xA system supports redundant server configurations that increases system availability, performance, and lessen the loss of data. Refer to Redundancy topic in *System 800xA, Post Installation (3BUA000156*) for more information.

Load balancing controls how clients connect to servers in different scenarios:

- A normal operation when all the servers are up and running.
- When one or more servers are down.

  When a server is down, to balance the load, drag and drop clients from the Unassigned Clients list on a server representation.

  Refer to Affinity topic in *System 800xA, Post Installation (3BUA000156*) for more information.

**System Directory Configuration**

When a single disk is used to store the data of all the services, it reduces the system performance significantly. The System Directory Configuration task allows the user to specify separate disks for storing the data to optimize the system performance.

The configuration for this task is a two step procedure:

1. Each service that needs to store the data must be configured to use the Server Data or Server Data 2 path.
2. The Server Data or Server Data 2 paths are then configured on each node running the respective service, to point to one of the existing disks on the node.

After moving the Operate IT Data folder, a reconcile of all the FF OPC Servers is required.

It is recommended that changes are made one node at a time to ensure that there is no loss of data.

The services using the same path will be disabled when changing the disk used by that path.

**Maintenance**

The Maintenance task group includes the tasks to configure the maintenance tasks such as, backup of the application data and load system extensions. A user with an Application Engineer role can perform the Maintenance tasks.

**Backup**

This function allows the user to back up application data in the following ways:
Section 3 System Configuration Console

Backup

Backup Now
When the user clicks the Backup now link, the default configuration is used to back up the data.

The backup can be stored only in nodes where backup service is running.

After the backup operation, the View existing backups dialog is displayed, refer to View Existing Backups on page 63.

Schedule Backup
An operator can select to back up the data at specified intervals. When the user enables this feature, the user can select how often the backup must be performed, how many backups to keep before purging the oldest backup, and the location where the backup must be performed and saved.

Purge Backup
The user can select the number of schedule backups to store on the disk before they are removed. When the specified number of backups is reached, the system automatically deletes the oldest backup.

The purge function only applies to backup taking using the system configuration console it does not include backups created using the workplace configuration.

View Existing Backups
This window displays details about the existing and ongoing backups. The user can abort an ongoing backup or remove an existing backup from this view.

The following four colors represent the different states of a backup:

- Blue – Ongoing backup.
- Green – Backup finished without errors.
- Yellow – Backup finished with warnings.
- Red – Backup finished with errors.
Users

This task group allows the system engineers to manage users in the system.

Add User
A system engineer can select to add a new user in the system. To add a new user, select a user from the list of domains available and click Create user.

Modify User
This task allows the system engineer to modify the user details and permissions.

Remove User
The system engineer can select and remove a user or a user group from the system.

Security

This task group allows the user to set permissions for all users and user groups in the system.

General Security
The user can configure the following general security settings from this console:

- Default Security Settings.
- Logover.
- Digital Signatures.
- Audit Trail.
- Authentication.
- Point of Control.
Default Security

A system engineer can configure the default security settings for users in the system, that is, select the different permissions that can be granted to users and user groups.

The configuration settings made using this task group affects all the nodes in the system.

For information about these settings, refer to *System 800xA, Administration and Security (3BSE037410*).
Section 4  System Status Viewer

The System Status Viewer shows status of different parts in the 800xA System. System status information can be available for both software processes and hardware units. The System Status Viewer aspect can be located on objects on different levels in all structures.

The System Status Viewer shows all objects that provide system status information. It reflects the structure of the Control System. All status information in the System Status Viewer is updated dynamically when a change of status occurs.

Figure 39. System Status Viewer - An Overview
Tools in the System Status Application Bar

Use the Next and Previous arrows in the upper left part of the figure, to get the previous or next status.

To find out where the source of the status is, click the Find Child Error button, see Figure 39. It is possible to make all objects with errors or warnings visible by clicking the Show all Errors button.

By default the Status Viewer displays the objects in a tree view. In the list view you can sort the objects by different columns. To change between list view and tree view, select the View Mode button.

Click the Help button to view the Online Help for System Status.

Columns

In the Status column an icon is displayed presenting status for an object. Objects that do not provide system status information will not have an icon in the column. There are three possible status results: OK, Warning or Error.

![Status Icons]

*Figure 40. The Status column*

The background color of the Propagated Status will either be red (Error) or yellow (Warning). In some scenarios, there might be objects in the collapsed branch with both Error and Warning, then Error will be shown as propagated status.
Section 4  System Status Viewer

System Status Viewer Configuration

The **Time** column shows the time for the last error or warning. The **Description** column shows a description of the latest error or warning status for each object.

An x in the **Details** column indicates that there is more detailed information available about the status. To show it, double-click in the column.

**System Status Viewer Configuration**

Configuration of the viewer can be made in two ways. Some settings are made locally for a specific instance of the System Status Viewer. The rest of the settings are made per user and affects all System Status Viewers.

![Figure 41. Configuration View](image)

The local settings for a specific System Status Viewer are:

- **Default Structure**
  
  If the object that holds the System Status Viewer aspect is a member of several structures, it is possible to select which structure that will be displayed first.
• Initial expansion of Object Tree
  By configuring the initial expansion of tree, it is possible to control how the
  object tree in the viewer should be expanded.

  When **Enable local expand level** is checked, the settings for expansion done in
  the Config View are effective, otherwise the default settings done in User
  Profiles are effective.

Configuration can only be made if the System Status Viewer aspect is not
inherited from an object type.

The settings per user is made on the Status Viewer Profile Values aspect, located in
the User Structure.
Section 5  Reference Tool

Reference Tool is used to view the references of a single aspect or several aspects on the same object. The tool is started by selecting Reference Tool from the context menu of an aspect or an object. The tool can also be started from the Start menu, and an aspect or object can be dragged into the tool.

If the tool is used for an entire object, it displays the references of all aspects on the object that contain references. The references are then grouped by the source aspect.

Main functions of Reference Tool are:

- View the current references.
- Change the target of references.
- Automatically resolve the broken references.
- Approving non-approved aspects.

Using the Reference Tool

The Reference Tool with two source aspects (Graphic Element and Graphic Element 2) is as shown in Figure42.
Tab Views

Dynamic References
Dynamic References are context specific and reference other target aspects if the source aspect is inherited. These references are called Data References in Graphics Builder.

The Dynamic References tab always shows the translated references. If it is used in the Object Type Structure, it displays the references within the object type. If it is used on an inherited aspect on an instance, it displays the translated references valid for that instance.

Static References
Static References are not context specific and do not change if the source aspect is inherited. These references are called Resource References in Graphics Builder.

The number of references displayed in each tab can be seen in the tab header. The dynamic reference tab is selected by default.
Main Window

Tree view in the dialog shows the references at three levels: Object, Aspect and Property. Tree view is built hierarchically and each referenced object or aspect is displayed once.

Figure 42. Reference Tool

For example, there are two referenced properties in the General Properties aspect of the Tank object, see Figure42. The hierarchical structure allows the user to move a set of references from one aspect to another or from one object to another.
The object named Power is displayed in the group of referenced targets labeled Graphic Element and in the one named Graphic Element 2. This is because both source aspects have references to properties that reside on the Power object.

Changing the references for one source aspect will not affect the references for other source aspects.

The Reference Tool is a general tool that does not have complete knowledge about the internals of every aspect. Some operations might be done in aspect specific tools. For example, if a broken reference in a PG aspect cannot be corrected using Reference Tool, the user should open the Graphics Builder and correct it manually.

If references are changed, the Reference Tool window is immediately updated to show the new references. Click Save to store these references in the source aspects.

The Reference Tool window is not updated automatically if changes are done in other Reference Tool windows, or in the Graphics Builder. If the Reference Tool has been open for a while, click Refresh to update the tool with latest information. This is essential before performing the new changes.

The users are allowed to configure the columns visible in tree view of the Reference Tool window, by selecting Show Columns in the context menu of the source aspect. Table 1 shows the different columns.

Table 1. Reference Tool Columns

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Displays the reference as a tree view. This column is visible by default and can not be hidden.</td>
</tr>
<tr>
<td>Reference Type</td>
<td>Displays the type of the reference (e.g. aspect, property etc.). This column is visible by default.</td>
</tr>
<tr>
<td>Resolve Status</td>
<td>Displays a status symbol followed by the status text of the reference i.e. resolved, unresolved or any such status message. This column is visible by default.</td>
</tr>
<tr>
<td>ID</td>
<td>Displays the Unique ID of the referenced entity.</td>
</tr>
<tr>
<td>Relative Path</td>
<td>Displays the relative path between the source aspect and the reference target.</td>
</tr>
</tbody>
</table>


**Changing References**

To change a reference, the user can right click on a node in the tree view and launch a browser by selecting **Change** in the context menu.

Right click an object to launch an object browser and right click an aspect or a property to launch an aspect browser or a property browser respectively. Select a compatible target.

For example, when the user selects the Tank object (see Figure42) and replaces with another object, **General Properties** aspect should exist in the new object that contains two properties with the same names. This resolves the references to both properties.

> When a reference is changed, the tree view is updated to show the current information, including the resolve status of the reference.

**Resolving References**

Select **Resolve** from the context menu of a node in tree view to resolve unresolved references automatically. This is successful only if the source aspect contains symbolic name information about the target aspect, and the aspect can be uniquely identified using the name information. The resolve context menu option is dimmed out if the status is not set to unresolved or if the source aspect for the reference is inherited.

The following context menu appears on right clicking header area of the columns in the Reference Tool.

Select **Resolve All** from the context menu of the source aspect to resolve all unresolved references.

**Viewing References**

To follow the references recursively, select a target object or target aspect and select **View References** from the context menu. This opens the **Reference Tool** showing references from this object or aspect.
Approving References

Copying an aspect sometimes might set the aspect to an unapproved state. In such scenarios, the user should view, possibly change, and finally approve the references of that aspect. The aspect can be approved by using the Approve button. The Save button will also approve the aspect after updating the changes.

Find and Replace

All references to an object matching a specified substring, can be changed to another object by replacing this part of the object names. Click Find and Replace and the Find and Replace window appears.

![Find and Replace window](image)

Figure 43. Find and Replace

Specify the substring to be searched and specify the replacement string. Click Replace All to replace all searched substrings with the new string.

To keep changed object references, click OK.

For example, consider references to the objects A102 and A1104. By replacing A with B, the references are changed to B102 and B104 (if these objects actually exist in the system).
Section 6  Consistency Check

When a user is performing engineering tasks, configurations made to different parts and aspects of the system may become inconsistent or ambiguous. This can not be obvious and most of the times it is hard to find all such inconsistencies in a large system. For example, you can build a Process Graphic that uses an expression based on a property defined by an AC 800M Control Application. An application engineer can later remove that property from the control program and your graphic has become inconsistent. You can check this by either looking at the graphic display or open the graphic display in the Graphics Builder. However, in a large system, you cannot possibly open all graphic displays just to check if they work properly. Instead you use the Consistency Check Tool.

The consistency check can be used to find such inconsistent configurations and collects them in a consistency report. In some scenarios, consistency problems can even be repaired from the Consistency Check Tool, but usually, you have to manually reconfigure the specific aspect that is inconsistent.

Checking the consistency of aspects in a system can be done at any time using the Consistency Check Tool, but it is also a vital part of the deploy workflow (described in System 800xA Engineering, Engineering and Production Environments (3BSE045030*)). Therefore, checking the consistency of the data you are about to deploy, update or replace is encouraged by those tools. The Consistency Check Tool contains a few more buttons and options, but in essence, the consistency report presented and the actions you as a user can make are the same.

The consistency check control is used to check the consistency of aspects either from the consistency check tool, or using the deploy, update and replace tools.
The Consistency Check Tool is started from the Plant Explorer by clicking the **Launch Consistency Check tool** button in the engineering toolbar, see Figure 45.

A new instance of the Consistency Check Tool will then launch. You can have any number of consistency check tools active at the same time. The Consistency Check
Tool, when launched from the Plant Explorer, is empty from start, see Figure 46.

Figure 46. Consistency Check Tool launched from the Plant Explorer.

The left area lists the items you want to check the consistency for. This may be anything from a single aspect to a complete AC 800M Control Project. The right area lists the inconsistencies found and also allows you to save the consistency report or load an existing consistency report.

Items to check the consistency for can either be dragged and dropped from the Plant Explorer or added by using the Add Item button. Clicking the add item button will show the Select Item dialog, see Figure 47. In this dialog you can either choose what control project, control application or library to check, or you can select the Structure View and then select exactly what object or aspect to check.
Performing a Consistency Check

Consistency Checker Tool can run out of memory and crash if large structures are checked for consistency. Restart the tool and check the structures by dividing them into small parts.

When the items you want to check has been added, you click **Check** to start checking the consistency. The consistency check then walks through all aspects of the selected items and performs a consistency check on each aspect. Since this may take some time, it is possible at any time to stop the consistency check by clicking **Cancel**. The consistency check will then stop checking the consistency of the remaining aspects but the inconsistencies already found will be presented in the consistency report.

When the consistency is checked for an aspect, the consistency checker first looks at the aspect to find out if there are any inconsistencies that the system could discover.
by itself. This includes checking aspect references and entity definitions. The consistency checker automatically validates the references of the aspect against the system. The broken or ambiguous references are reported as errors.

The aspect itself can perform additional consistency checks by implementing the aspect consistency check interface. The consistency check will then call the aspect and the aspect can perform any custom consistency check and report back to the checker.

These checks are done by default, and the behavior can be customized through the Options dialog window opened up by clicking the Options button in the toolbar. See Figure 48.

![Figure 48. Consistency Check Options](image)

Select aspect checking (including entity checking) and reference checking individually. Checking references between aspects consume more time. Hence this reference check can be skipped if the user feels that all references are perfect.

Reference consistency, by default, checks only for target existence and not for the valid target location scope. Select **Scope consistency** to check for the target objects residing in a valid scope. For example, a valid reference scope may be within a composite object type. When the Scope consistency feature is enabled, the
Performing a Consistency Check

Section 6 Consistency Check

The consistency checker tool detects any reference defined from one object type to another object type and reports the scope inconsistency error.

Additional check of rescue information for references can be requested in the Options dialog. The rescue data is an information (for example, the name of the target object), and is used to repair the reference if broken. The existing rescue information (if any) is checked for correctness and errors by enabling the Rescue consistency check box in the Options Dialog.

By default, the consistency checker skips aspects in released libraries (they cannot be repaired). The user can check released libraries by enabling Skip released libraries check box in the Options dialog.

In the example (Figure 49) below, a Control Project has been checked and two errors detected. The two first inconsistencies comes from the same aspect; PX:Bookmark. The warning was generated by the aspects custom consistency check and tells the user that a file viewer aspect that was used no longer exists.

The second inconsistency was calculated by the Consistency Check Tool by validating the references of the bookmark. It also detected that the referenced aspect no longer exists and reports this as an error. In this case, the same aspect yielded two inconsistencies for the same problem; that the configured file viewer no longer exists. In some scenarios, it would make sense for the aspect to try to report a more detailed description of the problem than the general type errors that the consistency checker can produce.

![Consistency Check](image)

Figure 49. Consistency Check with two Errors
The consistency report contains a lot of columns and the report can be sorted on each column by clicking the column header. This can help to locate similar types of problems by e.g. sorting the reported inconsistencies by aspect category by clicking the **Category** column. It is also possible to see what system extension the specific aspect comes from if you need help to resolve or fix the conflict.

By right-clicking an inconsistency in the report, you either repair the aspect or look at the details for that specific inconsistency. The details will contain a lot of information and some of it may only make sense to a skilled engineer.

**Resolving and Repairing Errors**

In most of the scenarios, the consistency problems reported by the Consistency Check Tool will require that you locate the aspect that reported the problem, the source, and use the configuration view or similar for that aspect to resolve the problem.

For example, if a graphic display has an expression that refers to a property that no longer exists, open the Graphics Builder for that graphic display and correct the expression.

In some scenarios, an aspect can be automatically repaired by the Consistency Check Tool and this can be seen in the **Repairable** column. A repairable problem can be repaired by right-clicking the row or rows that you intend to repair and select **Repair** from the context menu. The consistency check will then repair the problem.
and update the consistency report. In some scenarios, you may have to perform a new consistency check again by clicking the **Check** button.

In the example below, the “SimpleModule” is an inconsistent entity that can be automatically repaired.

![Figure 51. Inconsistency that can be repaired](image1)

Right-click the repairable aspect and select **Repair Aspect**.

![Figure 52. Repairing an inconsistent aspect](image2)
Before the reparation of the aspect is started a dialog appears that tells you to make a backup before repairing the aspect. It is recommended to do that.

![Repair Dialog Box](image)

**Figure 53. Repair Dialog Box**

The Consistency Check Tool will then repair the aspect if possible and update the consistency report. There may be scenarios when the repairable aspect still cannot be automatically repaired because of some other problem. In these scenarios, you must manually reconfigure that aspect to resolve the problem.

**Consistency Check for Libraries**

Consistency check of a specific library version, e.g. "MyLibrary 1.0-0" can be done in two ways as described below:

1. By adding the library version to the Consistency Check tool as described above.
2. Using the Consistency tab on the Library Version Definition aspect for a library version object. Refer to System 800xA, Configuration (3BDS011222*), Appendix B Library Handling for more information on Consistency tab.

The Consistency Check tool performs a more complete check than the Consistency tab.

The consistency errors that are displayed by the Consistency tab or Consistency Check Tool for the PROFIBUS Device Types (delivered in the form of Hardware Libraries) by Device Integration can be ignored.
The consistency errors that are displayed by the Consistency tab or Consistency Check Tool for the Asset Optimization Object Type Libraries delivered by Asset Optimization can be ignored.

The consistency errors that are displayed by the Consistency tab or Consistency Check Tool for the PLC Connect Object Types delivered by PLC Connect can be ignored.

The Consistency tab is still useful to do a fast preliminary check of a library, but a complete consistency check using the Consistency Check tool is recommended before the library is released.

The Consistency tab is mostly intended for checking the internal object type and library configuration, and does not check e.g. references to properties.

**Workflow for Consistency Check**

A consistency check should be done before and after any major changes to the system. It is also recommended before a backup and after a restore of the system.

Consistency check can be performed as follows:

1. Consistency check of Libraries
   a. Perform a consistency check on the library entities from the Consistency Check tool. It is also possible to check consistency for a library entity on the Library Version Definition aspect.

2. Assignments on Libraries
   a. Check the aspects on all user defined libraries using the Aspects tab of the Library Version Definition aspect. See Aspect Assignments. It is recommended that all aspects are assigned to the library.

3. Consistency check of Applications and Controllers
   a. Launch the Consistency Check tool and add all Applications entities from the Control Structure. Check consistency.
   b. Launch the Consistency Check tool and add all Controller entities from the Control Structure. Check consistency.

4. Consistency of Log Configurations

Aspect Assignments

Aspects that are not assigned to the library will not be part of the exported library. They will also be left out when a new library version is created. Aspects located in extensions libraries will also be listed as aspects not included in the library.

Figure 54. Aspects tab on the Library Version Definition aspect

If there are aspects in the “Aspects not included in the library” list where a library is not assigned (the Library column is empty), move them to the “Aspects included in the Library” list with the “<” button.
Log Configurations

If inconsistency error is detected on the Log Summary aspect, right-click on the line for the erroneous Log Configuration and select Autocorrect references from the context menu.

Figure 55. Log Summary aspect with consistency check
Section 7 Diagnostics Collection Tool

The ABB Diagnostics Collection Tool (DCT) is used to collect diagnostics information for analysis from a local or remote node in a distributed LAN system. The data is packaged into compressed cabinet (.cab) files that are attached to the reported problem.

- System Checker tool is now merged with the Diagnostics Collection Tool. System checker functionalities like System Information Collection, Node Report, System Report Analyzer etc., are now available as DCT Plug-ins.
- DCT must run by a user having Administrator rights, else it will lead to inaccurate results or uncertain behavior of the tool.
- If a user without Built-in administrator rights tries to run DCT, then the User Account Control (UAC) warning dialog appears.

The purpose of the DCT tool is to unify the information gathering process for all ABB IndustrialIT products from installations at customer sites. This speeds up the problem resolution process performed by the ABB support organization.

The ABB DCT enables diagnostics information gathering from several IndustrialIT products in a consistent way.
The main functions of the tool are:

- Collect diagnostics data from nodes in a distributed system.
- Explore the contents of the collected data.
- Analyze relevant parts of the collected data.
- Auto collect plug-in data based on scheduling.
- Collect basic data for troubleshooting.
- Collect software consistency data based on predefined plug-in configuration.

**Supported Diagnostics Information**

A set of plug-ins supporting DCT collection capabilities are bundled with DCT. The plug-ins are separated into two categories, 800xA and Standard.

The following plug-ins are installed with DCT:

**800xA Plug-ins**

These plug-ins collects data from 800xA:
- Batch™.
- OPC Server for AC 800M.
- Control Builder M.
- Harmony Connect.
- License Information.
- Log File.
- Shared Memory Dump.
- System Extension Checksum.
- System Report.
- PLC Connect and SoftPoint Server.

**Standard Plug-ins**

These plug-ins are targeted at collecting information about the operating system:
- Diagnostics Collection Tool.
- DLL List.
- DNS Information.
Section 7  Diagnostics Collection Tool  On-line Help

- Environment Variables.
- Windows Error Reported.
- Event Logs.
- Handle List.
- Installed Software.
- Process Information List.
- Registry Dump.
- SQL Diagnostics.
- System Information.
- Task Manager.
- User Dump.

For more information on plug-ins, refer to Plug-ins on page 145.

On-line Help

Press F1 to invoke on-line help for the relevant DCT topic or click on Help menu.

Starting DCT

Command Line Arguments

DCT supports a number of command line arguments that configure how DCT must start and work. To see a list of available arguments, start DCT and pass the "/?" argument to it.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Auto Collector&gt;</td>
<td>If a file name of an Auto Collector is passed as an argument, DCT will show the Run Auto Collector wizard. After the Auto Collector has finished, DCT will automatically exit.</td>
</tr>
<tr>
<td>/silent</td>
<td>This option can be used together with the file name of an Auto Collector. If this option is used, DCT will run the Auto Collector without showing any GUI. After the Auto Collector has finished, DCT will exit.</td>
</tr>
</tbody>
</table>
Example: Starting the Analyzer

To skip the Launch Pad and view the Analyzer Tool directly on startup of DCT, start it as follows:

1. "<Sys dir>:\Program Files\ABB Industrial IT\Diagnostics Collection Tool\ABB Diagnostics Collection Tool.exe" /tool:DataAnalyzer.
Command line arguments can be specified by creating a shortcut to DCT and modifying the **Target** field to include any arguments.

![Figure 56. Diagnostic Collection Tool - Shortcut Tab](image)

**Launch Pad**

The Launch Pad is the initial window seen when starting DCT. This window is used to start other components of DCT.
To start the tool, select the appropriate radio button and click **OK**, see Figure 57.

*Figure 57. ABB Diagnostics Collection Tool*
Available Tools

The components available on the Launch Pad are:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect Data</td>
<td>Collects data from the nodes in the network. For more information, refer to Collecting Data on page 107.</td>
</tr>
<tr>
<td>Explore Data</td>
<td>Explores the collections done with the Collect Tool. For more information, refer to Exploring Data on page 118.</td>
</tr>
<tr>
<td>Analyze Data</td>
<td>Performs analysis on the collected data. For more information, refer to Analyzing Data on page 128.</td>
</tr>
<tr>
<td>Create Auto Collector</td>
<td>Creates an Auto Collector that can be used to collect data. For more information about how to create Auto Collectors, refer to Creating an Auto Collector on page 99, and for general information about Auto Collectors, refer to Configuring DCT Options on page 95.</td>
</tr>
<tr>
<td>Collect Basic Data</td>
<td>Use this option to run one of the installed Auto Collectors. For more information, refer to Running an Auto Collector on page 105.</td>
</tr>
<tr>
<td>Collect Software Consistency Data</td>
<td>Collects installed software information for different products from all the 800xA nodes for consistency analysis. For more information, refer to Collect Software Consistency Data on page 143.</td>
</tr>
</tbody>
</table>

Refer to Command Line Arguments on page 91 to start one of the tools using DCT without showing the launch pad.

Configuring DCT Options

To configure DCT options, select Tools > Options.

Modifying Results Location

Use this to specify the location where the results will be saved. This includes the results from both collections and Auto Collectors and is also the location where created Auto Collectors will be stored. The default location is C:\ABBResults. In
this folder, each collection will create a new folder according to the date and time when data was gathered.

1. To change the results directory, click **Browse** and select the desired directory. If the results folder is changed, any old collections in that folder will have to be moved to the new location for it to show up in the Collection Analyzer and Collection Explorer.

2. To open the relevant directories, click on the two blue links that appear below the text field.

![DCT Configuration Dialog](image)

*Figure 58. DCT Configuration Dialog*
**Node Execution**

This setting controls how the collection jobs are executed when DCT is collecting data from several nodes. The default value is to run the jobs sequentially. The second alternative is to run the jobs in parallel, see Figure 58.

It is recommended to execute the jobs sequentially. Do not change this setting from its default value unless absolutely sure that it will not have negative impact on the system.

**Deleting Results**

When DCT collects data from the remote nodes, it will keep the collection in its own results location. Over time, this can lead to a huge amount of irrelevant collections being scattered on all nodes. This is why DCT contains options that controls this behavior. See Figure 59 for information about the DCT delete options.

![Figure 59. DCT delete options](Image)
Delete After Collect

This option controls whether DCT should remove the collection from the remote node after it has collected and downloaded it to the local node. This option also controls the behavior of the Auto Collector, refer to Collecting Data on page 107.

If DCT is not setup to download results after collecting, this option will be ignored and the collection will be kept on the remote node.

Delete After Download

This option controls DCT's behavior when it downloads collections in the Collection Explorer. By default, DCT keeps a copy of the collection on the remote node while downloading. Enable this option for DCT to automatically remove the collection after a successful download, refer to Downloading a Collection on page 121.

Collections can be removed from remote nodes manually using the Delete Collection functionality.

General Settings

Splash Screen

The splash screen is the first screen seen during startup and can be disabled during startup. On launching DCT, select either Collect Data or Explore Data, click OK. Select Tools > Options, uncheck the Show the splash screen at startup option. The startup time may be slightly faster with the splash screen turned off, refer to Figure 59.

Downloading Results

DCT splits the files into multiple equal parts before downloading to the local node, while gathering the data from the remote nodes. The default chunk size is set to 10 MB. The file size can range from 1 to 15 MB, refer to Figure 59.
**Auto Collector**

The Auto Collector tool creates a scripted collection that can run on a 800xA system. Support engineers do not have to call customers and have them manually select nodes and plug-ins in DCT. A support engineer creates a single file, that can be sent to the end user by E-mail. Initially end users should launch the received file to collect the necessary data that can be returned to ABB. **Work Flow**

A typical workflow of solving a customers problem using an Auto Collector is explained below:

1. End users identify a problem and calls ABB support lines.
2. The support engineer creates an Auto Collector file and sends it to the end user.
3. The file is received and is run on the end user’s system.
4. The Auto Collector files collect data from the local node and send it back to ABB.
5. ABB support engineers analyze the data and identify a solution for the problem.
6. A solution is provided by ABB to the end user.

**Creating an Auto Collector**

To create an Auto Collector, open DCT and select the **Create Auto Collector** option.

A new dialog will appear that will guide you through the process, see **Figure 57**.

Double-click on the image or the description text of a tool to start it.

**Message Page**

A message is displayed before the actual collection begins. It can be anything that makes sense to the user, but it is good to provide some short information about why one should run the Auto Collector.
Adding and deleting a new message template to the list can be done as follows:

1. To add a message template, write a message in the text box and click **Save**, see Figure 60.

   The first couple of words are used for the title of the message. To use this message template choose it from the drop down list.

2. To delete a template from the list of installed templates, select it from the list (the message will show up in the text box), and click **Delete**, see Figure 60.

   A template can be deleted by pressing the **Delete** key on the keyboard while the message template list is selected.

**Password**

The Auto Collector can be password protected and will not run unless the correct password is entered.
Split Page

The Split Results option automatically splits the results on a machine into smaller parts. Use this option to break larger files into smaller parts before transferring them. A couple of predefined sizes are available in the drop down menu. To customize the size, select “Custom Size” in the list and enter the size in megabytes.

Scheduling Page

If the Auto Collector is scheduled and the Auto Collector file is launched once, it will reschedule itself to run at a different time. Selecting the check box at the top of the page enables scheduling and the rest of the controls in the page.

If the Schedule this Auto Collection option is enabled, manually run the autocollector file for the first time after creating it. This adds the file to the Windows Scheduled Task. The Auto Collector file then runs according to the configuration in Scheduling Options.

Setting a start time

The start on time indicates the time and date when the Auto Collector must run for the first time. It can either be a specific time or relative time from then the Auto Collector file is clicked.

<table>
<thead>
<tr>
<th>Scheduling Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start on</td>
</tr>
<tr>
<td>[ ] Fixed time:</td>
</tr>
<tr>
<td>[ ] Relative time:</td>
</tr>
</tbody>
</table>

Figure 61. Scheduling Options

If a Fixed time is selected, the Auto Collector file is launched on the target node. The auto collection will be scheduled to run at the date and time specified in the Fixed time of the scheduling options, see Figure 61.

If a Relative time is selected, the Auto Collector file is launched on the target node. The auto collector runs after the specified time elapses following the first launch of
the auto collector file. A relative time can be specified in terms of Minutes, Hours, Days, or Weeks. Let us consider the below example.

**Relative start time example**

A relative time is specified with a setting of four hours from launch time. The Auto Collector is sent to the end user and can be started by double clicking on it from Windows Explorer. If the time is 09:45 (AM) on the end user’s machine the Auto Collector is set to schedule itself and will not collect any data at this point. The scheduled start time is calculated to be 09:45 + 4 hours. At 13:45, the system invokes the Auto Collector and starts collecting data.

**Intervals and Number of Runs**

If the Auto Collector is required to run several times, an interval and total number of runs must be specified. The run setting specifies the number of times the Auto Collector collects data before removing itself from the schedule. An interval must be set if the number of runs is greater than one. The interval specified is in minutes, hours, days, weeks or month between each run, see Figure 62.

![Figure 62. Interval Settings](image)

**Verifying the Schedule**

At the bottom of the page, there is a text message in English, describing the selected settings, see Figure 63. Use this to verify the selection with the expected behavior.
Section 7  Diagnostics Collection Tool

Creating an Auto Collector

The information entered here can be seen while running the Auto Collector.

End users may not know how and where to return the results if correct information is not entered here.

The Support Case ID number related to this Auto Collector should be added along with the contact information. The Case ID can be anything, but typical usage could be a ABB Supportline or PowerHelp numbers or similar. This Case ID will be displayed and included in the results returned.

Input Checking

The text boxes have input checking and will indicate when something is incorrectly entered in the fields. An incorrect field is highlighted by the little warning icon at the right side. It is possible to continue using the wizard even when these icons are shown.

The Auto Collector wizard expects inputs like Name, E-mail, Telephone, and Case Number (optional).

Command File Page

The Command File is an XML file containing information about the nodes and plug-ins to be queried. Export Command file is used to generate the command files that can be opened in DCT 5.0 or previous versions.

It is possible to add several command files to an Auto Collector. Each file will run separately and all result files will be merged in the end.

To add a file to the list:

1. Click the Add button.

Figure 63. Verify Schedule Settings
2. When a file browser dialog pops up, select the required files. It is possible to select multiple files in the file browser dialog.

   To remove a file from the list, click the **Remove** button after selecting the file from the list.

   To create a new command file:
   1. Click the **Create Command File**... button.
   2. Select the nodes and plug-ins from the Collection Tool window.
   3. When done selecting, save the new command file and close the **Collection Tool** window.

   The newly created command file will automatically be added to the list of command files.

   **Information**
   When creating the command file for nodes existing on a separate customer network. It is important that the node names match with what exists on that network otherwise the autocollector file will not be able to collect diagnostics for that designated node with node name mismatch. Contact ABB Technical support when configuring the export command file.

**Install Collector Page**

The created Auto Collector can install itself on the end user’s machine and can be invoked at a later time. This may be beneficial if the problem under investigation is occurring often and needs the same set of log information every time. The end user can run the installed collector and send the results with the initial support request without ABB Support sending an Auto Collector first.

   To install the Auto Collector, enter a description of it in the text field. This description will then be available in the drop down list of installed collectors.

   The description entered should be formulated as a symptom description.
Summary Page

The Auto Collector created will be in the results directory specified in the option dialog. For more information, refer to Modifying Results Location on page 95.

Running an Auto Collector

An Auto Collector is a script created by the support engineer to collect information about a faulty system. It does this by querying the nodes in the system for the information determined necessary to solve the problem.

The result of the Auto Collector will be one or more .cab files containing various information such as log files, DLL lists and version information. The results must be returned to ABB Support after the Auto Collector has finished its run.

Starting an Auto Collector

There are two ways to start an Auto Collector:

1. Starting an Auto Collector file directly.
2. Running a pre-installed Auto Collector.

Auto Collector files are typically sent from ABB Support to help end users with a reported problem.

To start an Auto Collector file, double-click on it in the file explorer or in the E-mail program. A wizard guides the user through the rest of the process.

Installed Auto Collectors should be used as a first step to speed up the problem tracking process. Typically, a couple of preconfigured Auto Collector scripts are installed along with DCT that provides a good selection of plug-ins and nodes aimed at solving generic problems.

Running an Installed Auto Collector

Select a symptom that best matches the problem from the list. When uncertain what the problem could be, or nothing in the list matches the problem, select “I don’t know what the problem is” from the list. For more information, see Figure 64.
Running an Auto Collector Section 7 Diagnostics Collection Tool

Providing Additional Information

Enter any additional information about the problem which is relevant to ABB Support. It can be a problem description, contact information or something else. Specify the Support Case ID number of the problem. Leave this field blank or at the default value if uncertain of the number.

Selecting Results Location

This page is displayed, only if there is insufficient amount of disk space in the default location.

Use the Browse to select a location to save the results. It is possible to select network locations too.

While importing the auto collector data or launching the auto collector file on a local node from a network path without mapping the drive may lead to unexpected error.

The resulting .cab files can be quite large in size. Sending this file by E-mail is dependent on your E-mail system configurations. Contact your local IT administrator for assistance if necessary.

Figure 64. Available Symptoms
Collecting Data

The collection functionality is the most significant feature of DCT. It allows selecting the type of data and the set of nodes to collect data from. Data collected can be viewed or analyzed using other tools available in DCT.

Starting the Collection Tool

To start the Collection Tool:

1. Double click on the image or on the description to start the DCT application, for details, refer to Starting DCT on page 91.
   The Launch Pad is displayed after the initial splash screen.
2. Select the Collect Data option from the list and click OK.

Making Your First Collection

To collect diagnostics data:

1. Select the nodes and plug-ins for these nodes from the list. Figure 65 shows the Collection Tool and a number of nodes and plug-ins.
2. Set the network type to use.

   When the Collection Tool is started for the first time, it will show only the local machine.
3. Click the network type button in the top left corner of the toolbar to change the network type, see Figure 66.
4. Select one of the network types (800xA Nodes, Network, or Local Node) from the drop down menu.

<table>
<thead>
<tr>
<th>Show only local node</th>
<th>Displays only the current machine in the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>List 800xA PPA nodes</td>
<td>Displays all machines that are part of the same 800xA network as the local machine.</td>
</tr>
<tr>
<td>List 800xA PPB nodes</td>
<td>This network type is only available in Melody connectivity and Melody Config server. Displays Melody connectivity and Melody Config server that are part of the same 800xA network.</td>
</tr>
<tr>
<td>List all nodes in the current domain</td>
<td>Shows all machines that can be found on the network (current domain or workgroup).</td>
</tr>
</tbody>
</table>

DCT will only extract information from the nodes that are on the specified network.

**Selecting What to Collect**

To begin collecting information:

1. Click the + sign on the left of the node name to expand it. The node can also be expanded by double clicking on it.

For for the selected node, DCT starts loading the plug-ins immediately if they have not been loaded. This takes a couple of seconds to complete, and will be indicated with a short text next to the node name, see Figure 67.

---

**Figure 67. Options to Collect**
2. Once the plug-in list is received, select it and configure them, see Figure 65.

3. Use the tree to select other nodes and plug-ins while DCT is still loading. An error message will be displayed next to the node name if the plug-ins cannot be loaded for a node, see Figure 65.

Information about the currently selected element in the tree can be seen in the properties panel to the right of the tree. For example, if DCT cannot load plug-ins from a node, it will display the reason in this box. Successfully loaded nodes will show the plug-ins.

4. Select a plug-in to view details about that particular plug-in.

**Collecting the data**

To start the collection:

1. Click **Collect** in the main toolbar.

2. Enter a description for the collection.

This description will be attached to the collection results and will be shown while exploring or analyzing the data, refer to Description Dialog on page 112.

3. Click **OK** after entering the description.

The collection progress window appears. The progress and status of all selected nodes can be viewed in this window. Figure 68 shows one node and the collection was successful indicated by the status label. A result is also generated.

<table>
<thead>
<tr>
<th>Name</th>
<th>Progress</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEONARD</td>
<td>Finished</td>
<td>C:\ABB\Results\05_09_07_14_28_49\leonard_05_09_07_14_2</td>
</tr>
</tbody>
</table>

*Figure 68. Status of collection*

Sometimes one or more nodes do not produce an output as shown in Figure 69. Also shown in Figure 69 is a node could not be contacted, and the reason is displayed in
the next column. Here the *Node Interrogator* was not running on the selected machine.

<table>
<thead>
<tr>
<th>Name</th>
<th>Status</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABB-DELI</td>
<td>Error</td>
<td>Failed to contact Node Interrogator</td>
</tr>
<tr>
<td>ABB-E7BG3GMKRYA</td>
<td>Error</td>
<td>Failed to contact Node Interrogator</td>
</tr>
<tr>
<td>EIP</td>
<td></td>
<td><em>Double Click to load</em></td>
</tr>
<tr>
<td>INL-TNX006088</td>
<td>Executing...</td>
<td></td>
</tr>
<tr>
<td>LCM1140</td>
<td>Finished</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 69. Collecting Diagnostics Information*

**Exploring or Analyzing Data**

Exploring or analyzing the collected data is the next step. Refer to *Exploring Data* on page 118 and *Analyzing Data* on page 128. To start these tools directly from within the Collection Tool, see *Figure 70*.  

*Figure 70. Collection Tools - Tools options*

Before importing a collection from a remote node, it is required to map the local drive to the remote location where the results folder is located otherwise the import operation might fail.
Description Dialog

To describe a collection use the description dialog. This description will be displayed in the collection explorer and can be used to find the collection later.

**Figure 71. Enter Description**

The dialog automatically saves the last ten descriptions and can be selected from the list.

To save a new description:

1. Enter the new description in the text box and click **OK**.
2. Click **Clear List** to clear all recent descriptions.
Section 7  Diagnostics Collection Tool  Saving Node and Plug-in Selections

Saving Node and Plug-in Selections

Selections can be saved in a special file called Command File. This eliminates manual selection of nodes and plug-ins every time a collection is made. A command file contains all the settings such as nodes, plug-ins, and individual plug-in settings.

To save your selection as a Command File:

1. Select File > Save Command File... from the main menu or click the Save button in the toolbar.

   Export Command File is intended to be used in 800xA 4.1 release. For System Version higher than 4.1, use Save Command File to export Command files and save the files.

To load a Command File using the toolbar:

1. Select File > Open Command File... from the main menu or click the Open button in the toolbar.

Searching For Nodes

The Collection Tool window contains many nodes. To find a node quickly, use the Find Nodes function.

1. Select Edit > Find Node... or Ctrl-F on your keyboard. A search bar appears below the list of nodes, see Figure 72.

   Figure 72. Search options

2. Enter the node description in the text box. DCT simultaneously starts searching for nodes that match the entered text.
3. Use the **Next** and **Previous** buttons to search for more matches. If DCT does not find a node that matches the entered text string, the text field turns red.

4. When done with the search, click **Close**. The search bar can be controlled entirely by using the keyboard as follows:
   a. Press **Ctrl+F** to start a search, enter the search string in the text box.
   b. Press **Enter** or **Alt+N** to find the next match of the current search string.
   c. Press **Alt+P** to search backwards for the previous match.
   d. Press **Esc** or **Alt+C** to close the search bar.

### Download Button

This only works for remote nodes. The download button will be disabled on single node systems.

Use the Download button to download the collection from a remote node to a local node.

The download button is used to gather collections that were collected on the respective nodes to a single node. When all the node specific collections are available on a single node, DCT can be used to compare the data node-wise.

When a collection is downloaded, it is still kept on the remote node. To download the collection and automatically remove it from the remote node:

1. Select **Tools > Options...** from the menu to open the options dialog. For more information, refer to **Delete After Collect** on page 98.

As soon as the download has completed, the collection will be available on your local machine for further analysis.

2. Click **Cancel** to cancel the download process at any time. This will only cancel any remaining downloads.

To download more than one collection at a time:

3. Hold down the **Ctrl** key and select all collections to download.

4. Click the **Download Collection** button.

Using the **Shift** key it is possible to select a range of collections.
Selection Rules

The selection rule functionality is a new feature in DCT 5.1. Traditionally, a collection in DCT was done by first selecting a set of nodes, and then a set of plug-ins for those nodes. This method works in many scenarios, but in some scenarios it is not possible to use this method.

<table>
<thead>
<tr>
<th>Case 1</th>
<th>Running a specific plug-in on all nodes in the network, for instance the &quot;Get Install Software&quot; plug-in. Doing this manually takes a lot of time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case 2</td>
<td>Creating a command file on a system not selected to perform a collection. Here the selected nodes are not available in the node list.</td>
</tr>
</tbody>
</table>

The new Selection Rules functionality resolves issues mentioned in the above scenarios.

Selection Rule

A Selection Rule is created using the Selection Wizard and it consists of three things:

1. A matching rule that specifies the nodes to select.
2. The type of network to select the nodes from.
3. A list of plug-ins to be executed on the selected nodes.

When DCT is doing a collection using a selection rule, it will locate all nodes that match the selected criteria and run the plug-ins on these nodes. The rule will be saved in the command file and can be loaded later on any machine running DCT 5.1.

Node Matching

The current version of DCT supports two ways to match nodes:

1. Match all nodes.
2. Match node names that match a certain criteria.

It is also possible to specify the type of network to search for the nodes. For details on creating Selection Rules and available options, refer to Selection Wizard on page 117.
Using the Selection Rule

Creation of a selection rule is indicated in the "Selection Rule Bar."

<table>
<thead>
<tr>
<th>Rule:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All nodes on 300xA PFA (1 plug-ins)</td>
<td>Configure Rule - Starts the selection wizard with the options specified in the selection rule.</td>
</tr>
</tbody>
</table>

In "selection rule" mode, you cannot manually select nodes and plugins. If you save a command file now, the selection rule will be evaluated on the computer where it is opened. You can also apply the filter on this computer to resume manual editing again.

Figure 73. Section Rule

The Selection Rule can be controlled using the following three control buttons:

- **Configure Rule** - Starts the selection wizard with the options specified in the selection rule.
- **Cancel Rule** - Discard the rule and allows manual selection of nodes and plugins.
- **Apply Rule** - Applies the selection rule on the current system and discards the rule.

**Apply rule**

Applies the rule to the nodes found from the current system. All nodes that from the list that match the criteria will be opened and relevant plug-ins selected. Once this is done, the rule is no longer active and it is possible to manually select or deselect plug-ins from the tree.

To collect data on the current system without applying the rule first:

1. Click **Collect** to collect data according to the settings in the Selection Rule.
Save rule
To save a Selection Rule, use the appropriate menu item or toolbar button to create a command file. This is useful while using the command file in an Auto Collector that can be run on another systems.

Selection Wizard
Use the Selection Wizard to create a Selection Rule containing a node and plug-in selection. The rule can then be applied on the system where the collection is to be performed.

A Selection Rule contains information on how to match a pattern against the nodes on a system. There are two types of matches that can be done:
1. Selecting all nodes.
2. Selecting nodes whose name match a certain criteria.

To know more about Selection Rules, refer to Selection Rules on page 115.

Selecting Nodes
Nodes can be matched by either their name, or can be set to match all nodes found on the network.

Name matching example
Assume the below nodes on a system, where the names of the nodes indicate the department (D1 = department 1 etc.), node type (WS -workstation, SRV -server, CLI -client), location of the node(206, 207 etc.), and finally a simple counter.

To run the collection on all nodes in room 207:
1. Enter "207" in the search field.

To run the collection on all workstations:
1. Enter "WS" in the search field.
Wildcards can be used to enhance the search match criteria. The available wildcards are *, which means "match any string", and ?, which means "match any character." For example using "D1-*-206" searches for all nodes belonging to department 1 in room 206.

**Selecting Network Type**

Once the node matching rule is selected, choose the type of network from where the nodes should be selected. These are the same types that can be selected in the Collection Tool, with the exception that the network type Local is not available. Creating a Selection Rule for only the local node does not serve any purpose.

**Selecting Plug-ins**

The next stage of the Selection Wizard is to select the plug-ins to be executed for the selected nodes.

1. Click the check box next to the name of the plug-ins to select it.
2. If the name of the plug-in on the target system is not available in the tree, Click Add and enter it. The target system is where the collection will be performed. A new category called Others containing the plug-in name is added.
3. Rename the new entry to match the real name of the plug-in. The name entered must match the plug-in name on the target system.

The name is case sensitive.

**Exploring Data**

Use the explorer tool to browse and view Collections created on the network. Collections located on remote nodes can be downloaded to the local machine, and collections that are no longer in use can be removed.

Refer to Starting the Collection Tool on page 107 and Starting DCT on page 91.
The Main Window

The explorer tool is divided into three sections, see Figure 74.

- Node List.
- Collection List.
- Collection Contents.
Using Collection Lists

Section 7  Diagnostics Collection Tool

Selecting Network Type

The first time the Collection Explorer is opened, it will only show the local node in the node list. To change this:

1. Click the network selection toolbar icon or click the network icon and select View > Network Type menu. For details, refer to Making Your First Collection on page 107.

<table>
<thead>
<tr>
<th>Node List</th>
<th>This list contains all the nodes that belong to the selected network type. For details, refer to Selecting Network Type on page 120.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collection List</td>
<td>The Collection List contains all collections found on the selected node in the Node List. The list displays the creation date, time and description of the collection. For details, refer to Using Collection Lists on page 120.</td>
</tr>
<tr>
<td>Collection Contents</td>
<td>Lists all the data found in the selected collection. The data is organized in a tree structure, with the name of the node from which data was collected at the top. The data files are grouped by plug-ins. For details, refer to Using Collection Contents List on page 124.</td>
</tr>
</tbody>
</table>

Every time the network type is changed, the Collection List and Node List is reloaded.

The node list will be populated with the nodes for the selected network.

Using Collection Lists

The Collection List contains a list of all the collections that are available on the selected node. The list is separated into two columns, the first contains the date and time when the collection was done, and the second contains the description entered for the collection. For collections made using an Auto Collector, the following message is displayed:

Auto Collector run by XYZ@NODENAME: This is a message.

It is not possible to change the description of a collection.
The three buttons to the right of the list are used to download, delete or view the properties of a collection. Moving the mouse pointer over each of these buttons displays the functionality of each of these buttons, see Figure 75.

**Figure 75. Buttons**

For details, refer to **Downloading a Collection** on page 121, **Deleting a Collection** on page 121 and **Viewing Collection Properties** on page 123.

**Downloading a Collection**

Refer to **Download Button** on page 114.

**Deleting a Collection**

Once a collection is deleted, DCT will permanently remove it from the currently selected node. This operation is not reversible. But, this could still be available on other nodes in the system if it has been downloaded.

To delete a collection:

1. Select it from the collection list and click the **Delete Collection** button.
2. Click **OK** in the confirmation dialog.
3. To cancel deletion, click **Cancel**. This will only cancel the remaining deletions. Any collection that has already been deleted will not be restored.
4. To delete more than one collection at a time hold down the **Ctrl** key while selecting the collections. Hold down the **Shift** key to select a range of collections.
5. Click the **Delete Collection** button.
**Importing a Collection**

Use this feature to import a collection into the DCT collection folder. The following collections can be imported:

- Any collection created with DCT 5.1.
- Old collections created by DCT 4.1 or 5.0.
- Results from an Auto Collector.

To import a collection:

1. Click the **Import** button in toolbar or from the main menu. A dialog appears which allows selecting the file(s) to import.
2. Once the collection is selected, click **OK** to start importing.

The list of collections will be automatically reloaded and the new collections will be visible on completion.

**Troubleshooting**

If the file is not a real collection, or it has been damaged in some way the DCT will be unable to import the selected collection. To correct this:

1. Open the cab file using WinZip or any other cab managing program.
2. Verify that the file opens correctly and that at least the following files exist in it:
   - __Manifest.xml.
   - __CommandManifest.xml.
3. Check that no other file is locking the collection, and that it exists in a location where DCT can read it.

If message: “Could not get node name and/or timestamp for collection” is displayed, check if the filename contains the node name from which it was collected.

A typical collection name is NODENAME_dd_mm_yy_HH_MM_SS.cab. If DCT cannot figure out the NODENAME part, it will not be able to import the collection.
Viewing Collection Properties

To see more information on a collection:

1. Click the **Collection Properties** button. This will show a properties window for the selected collection.

![Collection Properties Window](image)

*Figure 76. Collection Properties*

The properties window contains detailed information about the selected collection.

<table>
<thead>
<tr>
<th>Time</th>
<th>Time when the collection was started.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>User name of the person who performed the collection, including any domain settings.</td>
</tr>
<tr>
<td>Started From</td>
<td>Node where the collection was started.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the collection that was entered.</td>
</tr>
</tbody>
</table>

A list of all the nodes from where diagnostics data was collected is displayed. The start and end time of the collection performed along with each node name can also be viewed.
In some scenarios, the list of nodes in the properties window differ from the list of nodes in the **Collection Contents** list. This can happen for three reasons:

1. DCT did not download the collections to the local node when it was performing the collection.
2. The collection was downloaded, but has since then been deleted from the local node.
3. The collection was done from another node on the network, and all the results are available on that node. This is specified in the Started From field.

To copy the contents of the row to the clipboard, right click on the row or select **Copy Filename** from the menu.

**Using Collection Contents List**

The **Collection Contents** list displays all the data that was collected.

As shown in Figure 77, the contents are organized in a tree, with the node names as the top element. Below each node name is the list of selected plug-ins for that node, and each plug-in contains a list of files that it generates or collects.

To the right of the list, there are a couple of buttons that can be used:

For details, refer to **Opening a Collected File** on page 125, **Locating a Collected File** on page 126 and **View Collection Log** on page 126.
If a plug-in failed to collect data, it will be indicated with a warning or an error symbol next to the name of the plug-in.

**Icons**

Each element in the **Collection Contents** tree is represented by an icon. Below is a list of all icons and their definition.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Node" /></td>
<td>A node represents a single machine on the network. This is the top level item in the <strong>Collection Contents</strong> tree.</td>
</tr>
<tr>
<td><img src="image" alt="Plug-in" /></td>
<td>A plug-in is a component in DCT that collects data of some sort. Each plug-in in the tree contains one or more.</td>
</tr>
<tr>
<td><img src="image" alt="File" /></td>
<td>A file is the result of what a plug-in has collected.</td>
</tr>
<tr>
<td><img src="image" alt="Exception" /></td>
<td>This indicates that a plug-in encountered a serious error and failed to collect any data. This most likely means that there is a bug in the plug-in software.</td>
</tr>
<tr>
<td><img src="image" alt="Error" /></td>
<td>This indicates that a plug-in encountered an error while collecting data and most likely did not collect any data at all.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>The warning symbol indicates that the plug-in successfully completed collecting some data, but not all the data.</td>
</tr>
</tbody>
</table>

For more information on the errors and warnings, view the Collection Log.

**Opening a Collected File**

1. To view a collected file, simply double click on it or right click on a file and choose **Open** or click **Open File**.

The file will be opened in its associated viewer.

Example if a text file is selected it will be opened in notepad.

When browsing a remote node, the file will have to be downloaded first. This is handled automatically.
Locating a Collected File

This functionality is only available when exploring a local node. To view the collection from the normal Windows Explorer:

1. Select the file or right-click on the file in the Windows Explorer and select Locate on Disk.

View Collection Log

Use this functionality to view a detailed report of a collection. The log contains information written by DCT and the plug-ins during the collection phase. Messages are grouped by plug-ins and the total number of files added by that plug-in with the size of those uncompressed files are also displayed.

Messages

Messages can be shown or hidden using the filter buttons. By default, "Information" and "Debug" messages are hidden. The following types of messages exist:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceptions</td>
<td>They have the highest severity level and indicate a problem with the plug-in. In most of the scenarios, it indicates a bug in the plug-in software.</td>
</tr>
<tr>
<td>Errors</td>
<td>An error indicates that the plug-in failed to perform a task. For example, not finding a module or directory that it is supposed to find.</td>
</tr>
<tr>
<td>Warning</td>
<td>The warning message is the lowest severity level for log messages and indicates a problem. Typically, these messages indicate that a specific file or call did not work as expected, but the plug-in could collect some information.</td>
</tr>
<tr>
<td>Status</td>
<td>Status messages are just information messages that show the progress of the collection, see Figure 78.</td>
</tr>
<tr>
<td>Information</td>
<td>Information messages contain less important status messages on the execution process of the plug-ins.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debug messages are used by plug-in developers to trace the details of the plug-in execution. They are often very technical.</td>
</tr>
</tbody>
</table>
Collection Information

The blue box at the top of the log contains information about the collection.

<table>
<thead>
<tr>
<th>Issuer Node</th>
<th>The node on the system that started the collection, or on which the Auto Collector was run.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The time and date when the collection was started.</td>
</tr>
<tr>
<td>Author</td>
<td>Username of the person who started the collection.</td>
</tr>
<tr>
<td>Description</td>
<td>Description entered before the collection was started.</td>
</tr>
</tbody>
</table>

Figure 78. Log Messages for Collection
Analyzing Data

To analyze a collection:

1. Open DCT and select the **Analyze Data** option from the initial window, see Figure.

2. Select the analyze method to be used in the dialog.

Some of the standard analyze methods are:

<table>
<thead>
<tr>
<th>Analyze Software</th>
<th>Use the Software Analyzer to view softwares installed on different nodes, compare nodes, compare the nodes against the standard configuration, and to compare nodes with other collections. For details, refer to <strong>Analyze Software</strong> on page 131.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search in Collection or ABB Library</td>
<td>It is possible to search for a specified text in both a selected collection and in the ABB Library. For details, refer to <strong>Search in Collections or ABB Library</strong> on page 134.</td>
</tr>
<tr>
<td>Analyze Processes</td>
<td>Process Analyzer lists information on the running processes for the selected nodes. Differences between the nodes or time will be displayed. For details, refer to <strong>Analyze Processes</strong> on page 133.</td>
</tr>
<tr>
<td>Analyze Controllers Firmware and Log Files</td>
<td>Use this option to view controllers log files, and compare the installed firmwares. For details, refer to <strong>Analyze Controllers Firmware and Log Files</strong> on page 138.</td>
</tr>
</tbody>
</table>
Section 7  Diagnostics Collection Tool

Select Collection to Analyze

A list of collections located on the machine from where DCT is run is displayed.

1. Select the collection to analyze and click Next.

The collections in the list contain data and can be analyzed using the selected analyze method. For example, if Software Analyzer is selected, only collections containing the file installedsoftware.xml will appear in the list.

Only collections located on a local machine can be analyzed. Use the Collection Explorer to download collections situated on remote nodes.

Figure 79. Collection Analyzer

The available analyze methods are called standard analyze methods as these methods are available when DCT is installed.
The toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect</td>
<td>Use this button to perform a collection of data immediately. The collection</td>
</tr>
<tr>
<td></td>
<td>will only gather data that is relevant to the selected analyze method. One</td>
</tr>
<tr>
<td></td>
<td>can choose to either collect data from all nodes in the entire network, or</td>
</tr>
<tr>
<td></td>
<td>just the 800xA nodes.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports a collection into DCT that can be analyzed. When a file is received</td>
</tr>
<tr>
<td></td>
<td>use this button to import the collection into DCT’s internal file structure.</td>
</tr>
<tr>
<td></td>
<td>Once imported the list of collections will be updated and the imported</td>
</tr>
<tr>
<td></td>
<td>collection can be selected for analysis. For details, refer to Importing a</td>
</tr>
<tr>
<td></td>
<td>Collection on page 122.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the properties for the selected collection. For details, refer</td>
</tr>
<tr>
<td></td>
<td>to Viewing Collection Properties on page 123.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the list of collections on a local machine.</td>
</tr>
</tbody>
</table>

Use the Refresh button to update the list of collections when there is a scheduled Auto Collector collecting data in the background.

The information window to the right provides extended information as:

- Description of the collection.
- List of nodes in a collection containing data, that can be analyzed using the currently selected analyze method.

**Errors**

- In some scenarios, there may be errors in the files used by the analyzer. If DCT cannot parse the files, it will report this after it has processed all files.

  The reason for this error is most likely one of the following:

  - The system where the collection was made, and the system currently used have non compatible versions of the DCT.
  - The file may be damaged during the transfer to your computer. Download it again using the Collection Explorer.
  - The file may be damaged during collection. Try to do the collection again.
In some scenarios, an unexpected internal message is displayed if the collection explorer is opened to view the collection for Event Logs plug-ins when the Windows Event viewer is already open.

In some scenarios, the error is not severe, and data can be analyzed from the files that were correct. A message below the list of errors indicates this.

### Analyze Software

The Software Analyzer is used to:

- View installed softwares on the different nodes.
- Compare nodes.
- To compare the nodes with another collection.

When the Software Analyzer is invoked, two tabs are displayed:

1. Compare with saved collection.

   This tab has a **Browse** button to browse any other (old or new) collection of the same node, that is, the user can browse for any collection of the same node and see the difference in the node at the time of these collections.

   It is not possible to compare saved collections of different nodes.

2. Compare between nodes.

   This tab has the **Network Collection** option to collect data for multiple nodes. This collection will have data for all the nodes in the network. The **Compare between nodes** option will display a list of all nodes with a collection comparison chart.

   This option will not show any node list if the collection has information about a single node.
The **Analyze Toolbar**

Several analyze methods can be used through the Analyzer toolbar, see **Figure 80**.

![Figure 80. Toolbar for Analysis](image)

The action that will be performed when you click the buttons are described as:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Prints the table shown on the current selected tab.</td>
</tr>
<tr>
<td>Preview</td>
<td>Gives a preview of the results before sending it to the printer.</td>
</tr>
<tr>
<td>Collect</td>
<td>Opens the Collection Tool.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Opens the analyze wizard allowing selection a new analyze method. For details, refer to Analyzing Data on page 128.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the table shown on the current selected tab to Excel.</td>
</tr>
</tbody>
</table>

The **Print**, **Preview** and **Export** buttons all operate on the list/table in the currently selected tab only.

**Analyzing the software data**

The Software Analyzer provides three methods for analyzing the collected data:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare between nodes</td>
<td>Compares the software versions and installation dates on different nodes that are part of a collection. For details, refer to Comparing Between Nodes on page 141.</td>
</tr>
<tr>
<td>Compare with a saved collection</td>
<td>Can be used to see if any newly installed or upgraded applications are causing any problems. For details, refer to Comparing With a Saved Collection on page 142.</td>
</tr>
</tbody>
</table>
Analyze Processes

The Process Analyzer lists all running processes and their resource usage. The values can be compared between nodes or with other collections. Some of the resources that can be analyzed include:

- CPU Usage.
- Memory Usage.
- I/O Usage.
- Page file (virtual memory) usage.

The data types available are exactly the same as the Windows Performance Monitor (perfmon) counters.

After you have selected a collection to analyze, and the data files has been parsed, the following window will appear:

![Figure 81. Process Analyzer](image)

Refer to The Analyze Toolbar on page 132 for toolbar details.
Analyzing the process data

The Process Analyzer provides two methods for analyzing the collected data:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare between nodes</td>
<td>This method allows comparing the process data between the nodes that are part of a collection. E.g. to see if one process on a certain node uses more memory than the same process as the other nodes. For details, refer to Comparing Between Nodes on page 141.</td>
</tr>
<tr>
<td>Compare with a saved collection</td>
<td>Use this when there is a collection saved when the system was working correctly. For details, refer to Comparing With a Saved Collection on page 142</td>
</tr>
</tbody>
</table>

Search in Collections or ABB Library

The search module in the Analyze Tool is different from other analyze modules in DCT. Use the search tool to search through all the files in a collection for a text phrase.

The search tool can also be used to search for documents in ABB Library.

An end user does not have access to the ABB Library.

Main Window

The search tool window has two tabs, Search in files and Search in ABB Library.

- Search in files searches through all files in a collection for a text string.
Search in ABB Library searches for a document in ABB Library.

To use the Search in Collections or ABB Library feature, collections should be available for analysis. If the collections are not available for analysis, import the collections from a different node into the local node for analysis.

The Search in Collection or ABB Library does not have any associated DCT plug-in. Hence, the Collect button is disabled for this analyzer, see Figure 82.

Figure 82. Search in Collection
Search in Collections or ABB Library

Section 7  Diagnostics Collection Tool

Search in Files

To start a search:

1. Enter some text in the Search Phrase field.
2. Click **Search** or press the **Enter** key.
   A progress bar will appear in the lower right corner.
3. To stop the search click the little red icon to the left of the progress bar.

*Figure 83. Collect Analyzer*
The tree with the **Collection Contents** will be updated as new matches are found.

![Collection Contents Tree](Image)

*Figure 84. Collection Contents*

Matches are highlighted in blue with the word "found" after the filename. Clicking on a filename that contains a match, shows a snippet of the matching text in the Selected Item panel.

4. Wildcards can also be used in search.

5. To search for case sensitive text use Match Case option.
Analyze Controllers Firmware and Log Files

Search in ABB Library

Use this search tab to search for a text in the ABB Library document database. This functionality requires an active Intranet connection to work.

ABB Library can only be reached from the local ABB Intranet, and is not available to end users.

The Document Summary panel to the right of the list will display the summary for the selected document. The availability of this function depends on whether ABB Library provides a summary or not.

To open a document from the list double click on it or click on the blue Open Document link.

Analyze Controllers Firmware and Log Files

Controller Firmware and Log file analyzer is used to analyze the contents of the AC 800M firmware and Controller log files only.

It is not guaranteed that the log files created by controllers are parsed correctly. If the firmware information in the controller log analyzer does not display any data:

- Select the logs tab of the controller log analyzer.
- Apply appropriate filter.
- Read the controller related information.

There are two methods to choose analyze controller log files:

<table>
<thead>
<tr>
<th>From Collection</th>
<th>Analyzes controller log files that are inside a DCT collection. Click Browse Collections to select a collection to analyze.</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a Folder</td>
<td>Click Browse Folders to browse for the folder that contains the log files. DCT will automatically read and parse all files.</td>
</tr>
</tbody>
</table>

Refer to The Analyze Toolbar on page 132 for toolbar details.
Analyzing the Log Files

There are three analyze methods available:

<table>
<thead>
<tr>
<th>Logs</th>
<th>Shows all log messages for a specific controller. For details, refer to Viewing Logs on page 139.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare between nodes</td>
<td>Compares the process data between the nodes that are part of a collection. For details, refer to Comparing Between Nodes on page 141.</td>
</tr>
<tr>
<td>Compare with a saved collection</td>
<td>Use this when there is a collection saved when the system was working correctly. For details, refer to Comparing With a Saved Collection on page 142.</td>
</tr>
</tbody>
</table>

It is not possible to compare a set of log files with log files in another folder. The only way to compare is to use another collection of log files.

Viewing Logs

Logs tab in the analyzer window can be used to view the log messages for a specific controller. A log message consists of three things: A status, a time stamp, and a message. The status can be I for "information", W for "warning", E for "error" or F for "fatal". There are also messages without this information, and they are called "non timestamped messages" in DCT.

A controller can have several log files, and DCT will read all logs and merge them together as a single list. To make it easier to see which file a specific log message originated from, there is an option to color code rows depending on the file it was read from. This option is off by default.
Selecting a controller

To view log messages, select the controller and use the combo box.

Once a controller is selected, DCT populates a message list with all messages that belong to the selected controller.

A specific controller can have its log messages separated into multiple log files. DCT will automatically read all of them, and sort the entries based on the timestamp. If the same timestamp appears in multiple log files, the last one read by DCT will overwrite any previous entries.

Time span

Above the list of messages, DCT will print the time span for the messages. Due to the nature of the controller log file format, the timespan is limited to messages that have a timestamp. Messages before or after the timestamped messages in the log file will not be taken into consideration when calculating the span.

The timespan is calculated for all the files for the controller and all types of messages. It is therefore not recalculated when the filter is changed.
Message filtering

The log viewer has the ability to filter messages depending on their type and severity level. By default, all messages are shown, as indicated by the text <No Filter> in the filter combo box. To narrow the view to only specific messages, select the appropriate filter in the list.

Comparing Between Nodes

This option compares various data between nodes on a system. The type of data that can be compared depends completely on the selected analyze method.

For example, to be able to compare process statistics such as memory usage, handle lists etc. use the Process analyzer method.

The Software analyzer on the other hand, allows comparison of version numbers and installation dates of the installed software on the various nodes.

They all share a common user interface, that looks and behaves the same, regardless of analyze method.

For details, refer to Selecting what to compare on page 142.

Selecting nodes to compare

Select a node to be the "base" node. DCT will automatically highlight differences between the base node and any other selected node. All comparisons will be based on the values from this node, and other nodes' values will be highlighted in when they do not match those of your "base" node.

The list of nodes will depend on the selected collection, and whether they contain data that can be used for analysis or not.

Viewing the differences

After selecting what to compare, and the node to compare against select the analyzer to view the differences.

The column for the base node is all in blue, indicating that this is the "correct" value (or rather, the values to compare against). The other column, values are either displayed in black or in red, depending on whether they matched or not. If the value
Comparing With a Saved Collection

To graphically view any changes done to the system compare a collection with a previously saved one of the same node (preferably one made when everything was working).

For example, if suddenly a node starts to malfunction, use DCT to make a new collection. Select it in the analyze tool and compare it with a previous collection (say last month), when everything was working fine. Doing this may highlight for instance that a process is suddenly using 100% CPU while last month it was constantly running at 10%, or perhaps that a new software has been installed or upgraded that conflicts with the system.

Selecting what to compare

In the top left corner there is a drop down text box containing the available data types that can be compared. To the right of it, is a Browse... button that allows selecting a reference collection to compare against. Figure 86 shows a comparison...
Section 7  Diagnostics Collection Tool

Collect Software Consistency Data

for the Process analyzer.

The Collect Software Consistency Data functionality in the DCT tool allows collection of the data across all the 800xA nodes for the following list of pre-defined plug-ins:

- System Report
- Registry Dump
- Installed Software
- Task Manager

The data collection for software consistency analysis is done in easy steps.

Run the tool on the 800xA Node. Every node except the Domain Controller node where ABB Node Interrogator Service is running is identified as 800xA Node.

**Starting the Collect Software Consistency Data**

To start the Collect Software Consistency Data tool:

1. Start the DCT application, refer to Starting DCT on page 91 for more information.
2. Select **Collect Software Consistency Data** from the list of options in the Launch Pad screen.

3. Click **OK**.

The Collecting Software Consistency Data window (refer to Figure 87) will be displayed.

![Collecting Software Consistency Data](image)

*Figure 87. Collecting Software Consistency Data*

The result of the collection will be one or more `.cab` files containing information such as `System Report.ini`, `hklm_software_abb.txt`, `Installed Software.txt`, `Installed software.xml`, and `Task Manager.xml`. Data collection from every 800xA node is consolidated into a single `.cab` file.

The consolidated `.cab` file is stored in the following default location:

C:\ABBResults\<folder with current date and time of the collection>\SoftwareConsistencyData.
The link to the default location is provided at the bottom of the Collecting Software Consistency Data window (refer to Figure 87).

The data collected can be sent to ABB for software consistency analysis.

### Plug-ins

A plug-in is a small module in DCT that is responsible for collecting a specific type of data. There are several plug-ins available with the default installation of DCT, each targeting a certain data type.

#### IndustrialIT Related Plug-ins

**BatchIT**

This plug-in collects system log files generated by BatchIT. Collection of current log files, old log files or both can be specified.

**Control Builder M**

This plug-in collects log files generated by the Control Builder M software.

Some of the log files are:

- System Logs.
- Session Logs.
- Start Logs.
- Heap Statistics Log.
- Controller System Logs.
- System Information Report.
- Proﬁbus Logs.
- Crash Dumps.

The information gathered by this plug-in can be analyzed with the Analyze Tool.

Ensure the latest Controller log files are available before starting the collection of log files.
OPC Server for AC 800M

This plug-in collects log files generated by the OPC Server for AC 800M. For details, refer to System 800xA Control, AC 800M, Configuration (3BSE035980*).

Harmony Connect

Harmony Connect (ABBDiagnosticDump.exe) dumps the current state information maintained by the ABB Diagnostic Service for the server broker, and RTDS servers.

License Information

The License Information plug-in gathers comprehensive report from the node which has the ABB Central Licensing System server installed. The report contains all the available features, their installed attributes and how they are currently being used. The plug-in also gathers the errors log file from the Licensing server, CLSErrors.log.

To view the log files directly, click on View CSEError.log and View Feature Usage.

Log Files

This plug-in collects log files generated by 800xA Softwares and collects the data generated by Applog and System events.

System Log Files 📊

- Select what to collect 🌟
  - System Log
  - Active Port information
  - Config Wizard Log
  - App Log Messages

Figure 88. Log Files
**Config Wizard Log.** Creates a *Afw* `AfwConfigWizard.log` file that lists all the loaded files upon creation and startup of a system.

**AppLog Messages.** Application log (Applog) is the primary debug and diagnostics tool of PPA. This tool supports logging and states report operations.

To use Applog, enable it using the Configuration Wizard. Open the Configuration Wizard and select **Applog** to start the applog service. To configure it, start ApplogViewer and select the applications to trace log information from.

An Applog message contains the following attributes:
- Message Time.
- Application Name.
- Message Node.
- PID.
- Thread.
- Log.
- Log Level.
- Tag.
- Message Text.

**System Logs.** It collects all logs (System .log, Exception logs) created by 800xA softwares installed on the node.

**Active Port Information.** It Collects Active port information about Afw and Adv processes.

**Shared Memory Dump**

This will collect the hex dump files for 800xA applications.

**System Extension Checksum**

This will collect the XML files that have information of checksum calculations and versions for all files of each system extension.
System Report
This plug-in generates a system wide report on System Extensions, Applications, Users, 800xA Services.

It is generally recommended to execute this plug-in from an Aspect Server in the system.

Collect Data for this plug-in will generate the System Report.

System Report

To analyze the System report, the System Report Analyzer button is provided with plug-in GUI, see Figure 89. This button will launch the Excel Tool that structures the report into a sheet per node, see Figure 90.

To start the program:

Ensure the Microsoft Excel macro setting is set to disable all macros except digitally signed macros then click Options, select Trust all documents from this publisher, if the publisher for ABB is not added to the trusted list.

Launch the SystemReport.ini file from collection explorer by double clicking the file or using options to open file or locate on disk in collection content.
1. Click **System Report Analyzer**.

![Figure 90. System Check Helper](image)

2. Click **Convert Checker Report** in the Excel file to load the last generated report.
3. To edit the System Report, select **Create Node Application Relation** or **Create Node Service Relation**.

**Figure 92** shows the selected Create Node Application Relation.

4. Select the application to be compared and click **Ok**, see **Figure 92**.
Section 7  Diagnostics Collection Tool

IndustrialIT Related Plug-ins

Figure 92. Create Node Application Relation

Figure 93 shows a detailed system report.

Figure 93. Selected System Report
5. Select the **Advanced**... tab in the report to sort the result, see Figure 93 and Figure 94.

![Figure 94. Advanced Tab](image)

6. Select to sort the results using any one of the following filters:
   - Sort columns with Node Type.
   - Sort columns with Node Name.
   - Sort with Node Type & Name.

*Figure 95 displays a detailed system report sorted according to a filter criteria.*
Section 7 Diagnostics Collection Tool

IndustrialIT Related Plug-ins

Figure 95. Sorted System Report

System Report Error

The Aspect System must be UP for the DCT to generate the System Report. During collection of diagnostics data for system report plug-in, if DCT detects that a node is unreachable then DCT displays a warning message, see Figure 96.
Figure 96. System Report Log Messages

System Report generated by this plug-in consists of the following attributes:

System Wide

- System Name.
- System Extension.
- Affinity.

For each node in the System

- Type.
- Application.
Section 7 Diagnostics Collection Tool

Standard Plug-ins

- Network.
- Local Users.
- Node Services.

For the Domain Controller
- Domain Users.
- User Groups.
- User Roles.

PLC Connect and SoftPoint Server
This plug-in gathers the log files for the ABB PLC Connect and the ABB SoftPoint Server. Both share the same log files. PLC Connect is a connectivity option to Industrial IT 800xA that makes it possible to connect and integrate any type of remote or locally installed PLC, RTU, or other type of device.

ABB PLC Connect and the ABB SoftPoint Server are two different products that are installed separately, depending on node configuration any one or both the products are installed.

Standard Plug-ins
These plug-ins collect diagnostics information from the operating system running 800xA.

Diagnostics Collection Tool
This plug-in collects log files from DCT. Both the current log file (from the currently running DCT), and old log files are collected.

DLL List
Special characters are not allowed for process name in the DLL list plug-in.

DLL List plug-in (using Listdlls.exe) shows the full path names of loaded modules and not just their base names. In addition, DLL List will flag loaded DLLs having different version numbers from their corresponding on-disk files (which occurs
when the file is updated after a program loads the DLL). It also can tell which DLLs were relocated because they are not loaded at their base address.

Use the options provided to specify the list to collect. It is also possible to view the DLL list directly, by clicking on the View DLL List button.

**DNS Information**

This plug-in collects DNS lookup table with connection verification and writes all information in a text file.

**Environment Variables**

This plug-in collects all Environment Variables of the node and writes this information in to text file.

**Windows Error Reporting**

Windows Error Reporting is an error-handling mechanism for Windows systems. It detects and diagnoses program errors and logs the resulting diagnostics information. WER creates the Crash Report for individual applications.

All reports will be added in collection with the name of the corresponding application. The user can see the applications that were crashed in that duration, attach these reports to a mail, and send it to the corresponding product owners.
The user has two options to collect the crash dumps:
- All crash dumps on the system.
- Crash dumps in between specific dates.

**Event Logs**

This plug-in contains the functionality of the two plug-ins, System Event Logs and Custom Event Logs. System Event Log (*eventvwr.exe*) records system and hardware events as log entries on a server. There are three logs that are created by the operating system and some additional logs created by individual applications. The three system logs are:
- Application Event Log.
- Security Events Log.
- System Even Log.
This plug-in also collects custom event logs if they are available (and if specified in the configuration). If a software creates any event log, it will be displayed in the custom event log listing.

### ABB Diagnostic Collection Tool

Custom event log will be created for the first time when Autocollector is launched.

### Handle List

Handle List is a utility that displays information about open handles for any process in the system. Use it to see the programs that have a file open, or to see the object types and names of all the handles of a program.

### Installed Software

Installed Software Version Information is a small application that lists the installed products.

The information gathered by this plug-in can be analyzed with the Analyze Tool.

The installed software list may show GUID names instead of the display names. This is due to some hotfixes or software updates that may not have the display information.
Process Information List

Process List (pslist.exe) shows information from all the processes currently running on a system. This information includes the time of execution, execution time of the process in user and kernel modes, and the amount of physical memory the operating system has assigned to the process.

Check the box next to the name to view one or more of the following lists:

- Threads.
- Memory detail.
- Processes.
- Memory Threads.
- Process ID.

<table>
<thead>
<tr>
<th>Threads</th>
<th>Shows statistics for all active threads on the system.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Detail</td>
<td>Shows memory-oriented information for each process, rather than the default of CPU-oriented information.</td>
</tr>
<tr>
<td>Processes, Memory, Threads</td>
<td>Shows CPU, memory and thread information for each of the processes specified.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Instead of listing all of the running processes in the system, this parameter narrows the scan to those processes that begin with the name of the process or match a specific process ID. Process ID numbers can be obtained from the PID column of the Task Manager.</td>
</tr>
</tbody>
</table>

Registry Dump

Registry Dump plug-in dumps the registry data under either HKEY_LOCAL_MACHINE\SOFTWARE or HKEY_LOCAL_MACHINE\SOFTWARE\ABB. It can also be setup to dump any key in the registry if a full path is entered in the text box.

The information is reported as a text file (NT5 format).
SQL Diagnostics

SQL Diagnostics (sqldiag.exe) gathers diagnostics and current state information within a SQL server. This utility generates a file in the \Program Files\Microsoft\SQL Server\MSSQL\LOG directory called sqldiag.txt.

This utility can be run anytime, regardless of whether the SQL Server is started or not. If SQL Server is running, SQL Diagnostics gathers these items:

- Text of all error logs.
- Registry information.
- DLL version information.
- Output from:
  - sp_configure.
  - sp_who.
  - sp_lock.
  - sp_helppdb.
  - xp_msver.
  - sp_helpextendedproc.
  - sysprocesses.
  - Input buffer SPIDs/deadlock information.
  - Microsoft Diagnostics Report for the server, including:
    - Contents of <servername>.txt file.
    - Operating System version Report.
    - System Report.
    - Processor List.
    - Video Display Report.
    - Hard Drive Report.
    - Memory Report.
    - Services Report.
    - Drivers Report.
    - IRQ and Port Report.
    - DMA and Memory report.
    - Environment Report.
    - Network Report.
    - The last 100 queries and exceptions.
System Information

Microsoft System Information (MsInfo32.exe) provides hardware and software information about system configuration and status gathered from the registry. Two different formats are offered. One is TXT and the other is NFO (uses standard Microsoft System Information format).

Since a full collection by msinfo32.exe is time and resource demanding, there is an option to specify exactly the type of data to collect.

Task Manager

Task Manager provides information about programs and processes running on the selected computer. It also displays the most commonly used performance measures for processes.

The information gathered by this plug-in can be analyzed with the Analyze Tool.

User Dump

User dump can capture the state of a process and can be very useful when troubleshooting servers that have stopped responding and unresponsive processes. The plug-in must be configured to collect from a specific process, either by giving it a name or by selecting a process in the supplied list. If no configuration is done, the plug-in will not collect anything. This is a security precaution.

Process dump files are very large. Depending on the process you are dumping, you can end up with dump files that are several hundreds of megabytes large.
DCT Error Diagnostic Message

Diagnostics Collection Tool uses advance error reporting for unexpected internal errors.

![DCT Error Diagnostic Message]

*Figure 98. DCT Advanced Error Reporting*

In the error dialog:

1. Select **Open folder with error information file when click OK** checkbox.
2. Click **OK**.

The error log file is saved under ABBResults folder. See *Figure 98*.

**Frequently Asked Questions (FAQ)**

These are the frequently asked questions and answers about DCT.
Section 7  Diagnostics Collection Tool

Installation of DCT

Q: Can I use mixed versions of DCT on a system and have them communicated with each other?

A: No. Since the plug-ins from older versions of DCT is not compatible with the newer DCT version, it is not recommend to have such a setup. Also, older plug-ins do no generate analytical data, which means that data collected from old plug-ins, cannot be used in the Analyze Tool.

Q: Can the new version of DCT read old Collections that is, collections made by DCT 4.x or 5.0?

A: Yes, DCT 5.1 features an automatic import function that will detect old collections and convert them to the new format.

Use the Import function of Collection Explorer for this to work. Manually copying the collection to the ABBResults folder will not work.
Revision History

The revision index of this User Manual is not related to the 800xA 6.0 System Revision.

The following table lists the revision history of this User Manual.

<table>
<thead>
<tr>
<th>Revision Index</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Published for 800xA 6.0.1 release</td>
<td>October 2015</td>
</tr>
</tbody>
</table>
Index

A
Affinity 62
AppLog 53
Approving references 76
Aspect Server 25
Audit Trail 64
Authentication 64

B
Backup 62
Base installation 57

C
Child Error 68
Client 39
compressed cabinet 89
Connect Node 18
Connectivity Server 40
Consistency Check 77
Control System 67

dashboard 57
DCT 89
Device Integration 85
Diagnostics 19
Disconnect Client 19
Dynamic References 72

F
Faceplate 60
Find and Replace references 76

G
Graphic Element 71

H
Hardware Libraries 85

L
LAN 89
Load Balancing 61
Log Messages 154
Logover 64

N
network filtering 41
Node Report 89

O
Object Highlight 60
Object Tree 70

P
Personalization 59
Plug-ins 89
Point of Control 64
Power object 74
Process Object Lock 61
Process Portal A 48
PROFIBUS 85
Purge Backup 63

R
Recent events 58
Recent tasks 58
Redundancy 61
Index

Reference Tool 71
Reference Type 74
Relative Path 74
Report Analyzer 89
Resolve Status 74
Resolving references 75
Restore System 18

S
Security Report 64
Server Data 62
Server Data 2 62
Start Server 18
Start-up Mode 58
Static References 72
Status Viewer Profile Values 70
Stop Server 18
System Configuration Console 57
System Directory Configuration 62
System Extension 32
System Report 154

U
User Administration on IndustrialIT System 43
User Structure 70

V
Viewer Configuration 69
Viewing references 75

W
Workplace 61